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Дякуємо, що придбали наш пристрій. Якщо у вас виникли додаткові питання або запити, зверніться до  
дилера. 

Авторське право 

2015–2018 Zhejiang Uniview Technologies Co., Ltd. Всі права захищені. Жодна частина цього посібника 
не може бути скопійована, відтворена, перекладена або передана в будь-якій формі або будь-яким 
способом без попередньої письмової згоди нашої компанії. 

 

Визнання торгових марок 

 та інші торгові марки і логотипи Uniview є власністю Zhejiang Uniview Technologies Co., Ltd. Інші 

торгові марки, назви компаній і назви пристроїв, що містяться в цьому посібнику, є власністю 
відповідних власників. 

Обмеження відповідальності 

 
ПОПЕРЕДЖЕННЯ! 
Пароль за замовчуванням використовується тільки для першого входу. Щоб захистити свій 
обліковий запис, змініть пароль після першого входу. Рекомендуємо встановити надійний пароль 
(не менше восьми символів). 

 

 У максимальній мірі, дозволеній чинним законодавством, описаний пристрій, включно його 
апаратне забезпечення, програмне забезпечення, мікропрограмне забезпечення і документацією, 
надається на умовах «як є». 

 Хоча було докладено всіх зусиль для забезпечення цілісності та правильності вмісту цього 
посібника, жодне твердження, інформація чи рекомендація в цьому посібнику не повинні 
тлумачитися як офіційна гарантія будь-якого роду, явна чи непряма. Компанія не несе 
відповідальності за будь-які технічні або друкарські помилки, допущені в цьому посібнику. Зміст 
цього посібника може бути змінено без попередження. Оновлення будуть внесені в нову версію 
даного посібника. 

 Відповідальність за використання цього посібника, а також за подальші результати, лежить 
виключно на користувачеві. Ні за яких обставин компанія не несе відповідальності за будь-які 
фактичні, наслідкові, випадкові або непрямі збитки, включаючи, окрім іншого, втрачену 
комерційну вигоду, простої в роботі, втрату даних або документації у зв'язку з використанням 
цього пристрою. 

 Відео- та аудіоспостереження регулюється законами, які відрізняються в залежності від країни. 
Ознайомтеся із законодавством своєї країни, перш ніж використовувати цей пристрій для 
відеоспостереження. Компанія не несе відповідальності за будь-які наслідки, пов'язані з 
незаконним використанням цього пристрою. 

 Ілюстрації в посібнику наведені лише для довідки і можуть відрізнятися залежно від версії або 
моделі пристрою. Знімки екрана в цьому посібнику можуть бути змінені відповідно до конкретних 
вимог користувача. Тому деякі приклади та функції, наведені тут, можуть відрізнятися від того, що 
відображається на вашому моніторі. 



 

 Цей посібник є інструкцією для декількох моделей пристроїв і тому не призначений для 
конкретного виробу. 

 Через фактори невизначеності, такі як фізичне середовище, може виникнути невідповідність між 
фактичними і рекомендованими значеннями, вказаними в цьому посібнику. Наша компанія має 
виключне право інтерпретувати інформацію в посібнику. 

Захист навколишнього середовища 

Цей пристрій був розроблений з врахуванням вимог щодо охорони навколишнього середовища. Щоб 
забезпечити належне зберігання, використання та утилізацію цього пристрою, дотримуйтеь 
національних законів і нормативів. 

Символи 

Символи з таблиці нижче використовуються в цьому посібнику. Уважно дотримуйтесь вказівок, які 
супроводжують ці символи, щоб уникнути небезпечних ситуацій і правильно використовувати 
пристрій. 

Символ Опис 

 УВАГА! 
Звертає увагу на важливі інструкції з техніки безпеки і ситуації, які можуть 
призвести до травмування. 

 ЗАСТЕРЕЖЕННЯ! 

Інформує, що користувач повинен бути обережним, і про те, що 
неправильні дії можуть призвести до пошкодження пристрою або збоїв у 
його роботі. 

 ПРИМІТКА! 
Додаткова інформація, яка може виявитися корисною при використанні 
пристрою. 
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1  Підключення до мережі 

Перш ніж отримати доступ до мережної камери (вона також називається IP-камера або IPC) з 
комп'ютера, необхідно підключити камеру безпосередньо до ПК за допомогою мережного кабелю, 
або через комутатор/маршрутизатор. 

 
Щоб підключити мережеві інтерфейси мережної камери до ПК, використовуйте кабель з 
екранованними витими парами (STP). 

 

Щоб підключити мережеві інтерфейси камери до комутатора або маршрутизатора, використовуйте 
кабель з екранованними витими парами (STP). 

2   Вхід в систему 

Підготовка 

Після завершення інсталяції у відповіднсті з коротким посібником користувача, підключіть камеру до 
джерела живлення, щоб вона запустилася. Після запуску камери ви можете отримати доступ до неї за 
допомогою клієнта, встановленого на ПК з веб-браузером або клієнтським програмним 
забезпеченням EZStation. Рекомендований веб-браузер: Internet Explorer (IE). Для отримання 
додаткової інформації про  EZStation дивіться посібник користувача EZStation.  

Нижче наведено приклад використання браузера IE в операційній системі Microsoft Windows 7. 

Перевірка перед входом в систему 

 Камера працює нормально. 

 Мережеве підключення між ПК і камерою в нормі. 

 На комп'ютері, який ви використовуєте, встановлена версія браузера Internet Explorer 10.0 або 
вище. 

 Встановлена роздільна здатність 1440 x 900 (необов'язково). 

Network cable

IPC PC

IPC PCSwitch or Router

Network cable Network cable
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Додайте IP-адресу як адресу надійного сайту 

 

1.13

 

1

2
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 ПРИМІТКА! 
IP-адреса 192.168.1.13 у цьому прикладі є IP-адресою за замовчуванням. Замініть її фактичною адресою 
камери, якщо вона була змінена. 

 

Змінена параметрів керування доступом користувачів (необов'язково) 

Перш ніж ви отримєте доступ до камери, виконайте наведені нижче дії, щоб установити для параметра 
User Account Control Settings значення Never notify. 

 

Вхід у веб-інтерфейс 
Статична IP-адреса камери за замовчуванням: 192.168.1.13, а маска підмережі за замовчуванням: 
255.255.255.0. 

Протокол DHCP увімкнуто за замовчуванням. Якщо в мережі використовується сервер DHCP, IP-адреса 
вашої камери призначається в динамічному режимі, і ви повинні використовувати коректну IP-адресу 
для входу в систему. Щоб дізнатися динамічну IP-адресу вашої камери, скористайтеся клієнтом 
EZStation. 

Нижче показаний приклад входу в систему у браузері IE. 

1. Перейдіть на сторінку входу, ввівши IP-адресу вашої камери в рядок пошуку. 

 

2. Якщо ви входите в систему вперше, дотримуйтесь інструкцій на екрані та встановіть ActiveX. Для 
завершення установки необхідно закрити браузер. 

1

2

3

4
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 ПРИМІТКА! 
 Щоб завантажити ActiveX вручну, введіть у адресний рядок  

http://IP-address/ActiveX/Setup.exe і натисніть Enter. 
 Пароль за замовчуванням використовується тільки для першого входу в систему. Щоб 

захистити свій обліковий запис, змініть пароль після першого входу в систему. Рекомендуємо 
встановити надійний пароль (не менше восьми символів). 

 Камера має захист від незаконного доступу, обмежуючи кількість спроб невдалого входу. 
Після шести послідовних невдалих спроб входу камера автоматично блокується на десять 
хвилин. 

 

3. При першому вході користувача на екрані відображається політика конфіденційності. 
Ознайомившись з політикою конфіденційності, поставте галочку біля пункту «Я приймаю умови 
цієї політики», а потім натисніть кнопку OK, щоб перейти до наступного кроку.  

 

 

4. Введіть ім'я користувача і пароль, а потім натисніть на кнопку Login. Для першого входу 
використовуйте ім'я користувача за замовчуванням admin і пароль "123456". 

 Якщо ви увійдете в систему, вибравши Live View, то після входу буде відображатися відео в режимі 
реального часу. В іншому випадку вам потрібно буде запустити цю функцію вручну у вікні живого 
перегляду. 

 Якщо ви увійдете в систему, вибравши опцію Save Password, вам не потрібно буде вводити пароль 
щоразу під час входу. Однак для дотримання високого рівня безпеки не рекомендується вибирати 
опцію Save Password. 

 Щоб очистити текстові поля Username і Password, а також зняти галочку Save Password, натисніть 
Reset.  

Загальні відомості про веб-інтерфейс 

При вході у веб-інтерфейс, за замовчуванням відкривається вікно перегляду в режимі реального часу. 
Наступні ілюстрації наведено для прикладу. 
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№ Опис 

1 Меню 

2 
Область спостереження PTZ-камери 

Примітка.  
Ця область доступна для купольних і звичайних PTZ-камер. 

3 Вікно живого перегляду 

4 Панель інструментів для живого перегляду 

 

Початкове налаштування 
Після входу в інтерфейс пристрою виконайте початкове налаштування. 

Компонент Опис 

1. Ethernet. Повторно задайте IP-адресу і мережеві параметри пристрою 
відповідно до фактичної конфігурації мережі. 

2. Вийдіть із системи і знову ввійдіть у 
мережу, використовуючи нову IP-
адресу. 

- 

3. Налаштування системного часу. Встановіть фактичний системний час. 

4. Налаштування сервера керування 
(необов'язково). 

Налаштуйте сервер керування відповідно до фактичної 
конфігурації мережі. 

5. Налаштування сервера для 
зберігання фото (необов'язково). 

Налаштуйте сервер для зберігання фото відповідно до 
фактичної конфігурації мережі. 

6. Налаштування екранного інтерфейсу. Виберіть інформацію, яку потрібно відображати на екрані, 
наприклад час. 

7. Керування користувачами 
(необов'язково). 

Змініть пароль за замовчуванням і додайте користувачів якщо 
необхідно. 

 

1

2

3

4
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Після завершення початкового налаштування можна дивитися відео в режимі реального часу. За 
потреби налаштуйте інші параметри. 

 ПРИМІТКА! 
 Параметри і діапазони значень, що відображаються в інтерфейсі живого перегляду, залежать 

від конкретних моделей. Для отримання детальної інформації дивіться фактичний веб-
інтерфейс. 

 Параметри, що відображаються сірим кольором, не підлягають зміні. Щоб дізнатися фактичні 
параметри, дивіться веб-інтерфейс. 

 Після першого входу в систему рекомендується змінити пароль. Щоб отримати додаткові 
відомості про зміну пароля, див. Безпека. 

 

3  Налаштування параметрів 

Локальні параметри 

Установіть локальні параметри для свого ПК. 

 ПРИМІТКА! 
Локальні параметри можуть змінюватися в залежності від моделей. Для отримання детальних даних див. 
фактичний веб-інтерфейс. 

 

1. Виберіть команди Setup > Common > Local Settings. 
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2. Змініть налаштування відповідно до ваших потреб. У наведеній нижче таблиці описано деякі 
основні параметри. 

Параметр Опис 

Інтелектуальна 
мітка Некерована ціль При включенні камера відображає екранний знак на цілі (наприклад, на 

обличчі, коли включено розпізнавання облич) і відстежує його 

Відео 

Режим обробки 

 Пріоритет реального часу: рекомендовано, коли мережа в хорошому 
стані. 

 Пріоритет плавності: рекомендовано, якщо для живого відео потрібна 
коротка затримка. 

 Наднизька затримка: рекомендовано, якщо потрібна мінімальна 
затримка для живого відео. 

Протокол Встановіть протокол, що використовується для передачі потоків 
медіаданих, котрі будуть декодуватися ПК. 

Запис і знімки 

Запис 

 Розділ за часом: тривалість зареєстрованого відео для кожного файлу 
запису на комп'ютері. Наприклад, 2 хвилини. 

 Розділ за розміром: розмір кожного файлу запису, який зберігається на 
комп'ютері. Наприклад, 5 МБ. 

Перезапис 

 Перезапис: коли виділене сховище на комп'ютері заповнено, камера 
видаляє старі файли записів, щоб звільнити місце для нових. 

 Повна зупинка: коли виділене сховище на комп'ютері заповнено, запис 
автоматично зупиняється. 

Папка файлів 

 Місце зберігання знімків і записів. Максимальна довжина шляху 
збереження складає 260 байт. Якщо це значення перевищено, при 
перегляді в реальному часі запису або знімка станеться збій і на екрані 
з'явиться попередження. 

 

3. Натисніть кнопку Save для збереження. 

Налаштування мережі 

Інтерфейс Ethernet 

Змініть налаштування зв'язку, такі як IP-адреса камери, щоб камера могла підтримувати зв'язок з 
іншими пристроями. 

 ПРИМІТКА! 
 Після зміни IP-адреси буде необхідно увійти в систему з новою IP-адресою. 
 Налаштування сервера доменних імен (DNS) застосовуються в тому випадку, коли доступ до 

пристрою зздійснюється за допомогою доменного імені. 
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Статична IP-адреса 

4. Натисніть Setup > Network > Network. 

 
5. У випадаючому списку Obtain IP Address оберіть пункт Static. 

6. Введіть IP-адресу, маску підмережі і адресу шлюзу за замовчуванням. Переконайтеся, що IP-
адреса камери унікальна в мережі. 

7. Натисніть кнопку Save для збереження. 

PPPoE 

 ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для з’ясування подробиць див. фактичну модель. 

 

Якщо камера підключається до мережі по  протоколу двоточкового з’єднання через Ethernet (PPPoE), 
потрібно вибрати PPPoE як спосіб отримання IP-адреси. 

1. Натисніть Setup > Network > Network. 

 

2. У випадаючому списку Obtain IP Address виберіть пункт PPPoE. 

3. Введіть ім'я користувача і пароль, надані вашим інтернет-провайдером (ISP). 

4. Натисніть кнопку Save для збереження. 
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DHCP 

За замовчуванням для камери активований протокол динамічного конфігурування хоста (DHCP). Якщо 
в мережі розгорнуто сервер DHCP, камера зможе автоматично отримати IP-адресу від DHCP-сервера. 

Щоб настроїти DHCP вручну, виконайте такі дії.  

1. Натисніть Setup > Network > Network. 

 

2. У випадаючому списку Obtain IP Address оберіть пункт DHCP. 

3. Натисніть кнопку Save для збереження. 

IPv6 

1. Натисніть Setup > Network > Network. 

 
2. За замовчуванням для режиму IPv6 встановлена опція Manual. 

3. Введіть адресу IPv6, задайте довжину префіксу і шлюз за замовчуванням. IP-адреса повинна бути 
унікальною в мережі. 

4. Натисніть кнопку Save для збереження. 

Wi-Fi 

 ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для з’ясування подробиць див. фактичніу модель. 

1. Натисніть Setup > Network > Network. Відкрийте вкладку Wi-Fi. 

 
2. Виберіть Sniffer. 

3. Натисніть кнопку Save для збереження. 

Деякі пристрої можуть шукати мережі Wi-Fi і підключатися до них. 
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1. Виберіть Setup > Network > Network. Виберіть Wi-Fi для Wi-Fi Mode. 

 
2. Відобразиться рівень сигналу. Ввімкніть Adaptive Streams. На сторінці показано, що є й інші 

мережі Wi-Fi. Щоб знову шукати мережі Wi-Fi, натисніть Search. 

3. Натисніть назву (SSID) у списку мереж Wi-Fi. Відобразиться інформація про відповідну мережу. 

4. Натисніть кнопку Save для збереження. 

5. Якщо для режиму Wi-Fi Mode вибрано значення Wi-Fi Hotspot, камера може функціонувати як 
точка доступу Wi-Fi для інших пристроїв. 

 

6. Натисніть кнопку Save для збереження. 
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Порт 

 ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для з’ясування подробиць див. фактичніу модель. 

1. Натисніть Setup > Network > Port. 

 
2. Задайте відповідні номери портів. 

3. Натисніть кнопку Save для збереження. 

FTP 

Всі знімки (крім розпізнавання облич) зберігаються через загальну службу FTP. Після налаштування FTP 
ви зможете завантажувати знімки з мережевих камер на вказаний сервер FTP. 

Загальні характеристики 

1. Натисніть Setup > Storage > FTP. Перейдіть на вкладку General. 

 
2. Вкажіть IP-адресу і порт для FTP сервера, ім'я користувача та пароль, які використовуються для 

завантаження зображень на сервер FTP, виберіть Upload Images, Overwrite Storage і задайте 
значення Overwrite At (поріг для перезапису зображень). Деякі моделі камер підтримують 
тестування FTP. Після успішного налаштування FTP ви можете виконати тестування FTP. 

3. Задайте шлях для збереження знімків на сервер FTP та формат імені файла. Наприклад, задайте 
шлях як № предустановки \\IP-адреса\\дата\\час і встановіть ім'я файлу як № предустановки-зум 
PTZ-широта PTZ-довгота PTZ.jpg. 

4. Натисніть кнопку Save для збереження. 
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Smart 

Ця функція використовується щоб зберігати знімки, зроблені для інтелектуальних функцій, таких як 
розпізнавання облич. Щоб скористатися smart FTP, натисніть Setup > System > Server > Intelligent Server 
і виберіть FTP в рядку Platform Communication Type. 

1. Натисніть Setup > Storage > FTP. Перейдіть на вкладку Smart. 

 
2. Вкажіть IP-адресу і порт для FTP сервера, ім'я користувача та пароль, які використовуються для 

завантаження зображень на сервер FTP. 

3. Задайте шлях для збереження знімків на сервер FTP і формат імені файла. Наприклад, задайте 
шлях як № предустановки \\IP-адреса\\дата\\час і встановіть ім'я файлу як № предустановки-зум 
PTZ-широта PTZ-довгота PTZ.jpg. 

4. Натисніть кнопку Save для збереження. 

Електронна пошта 

Після налаштування електронної пошти на вказану вами адресу надсилатимуться оповіщення в разі 
спрацьювання сигналізації. 
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1. Натисніть Setup > Network > E-mail. 

 

2. Встановіть відповідні параметри для відправника і одержувача. Деякі моделі камер підтримують 
тестування електронної пошти. Ви можете перевірити електронну пошту після введення адреси 
одержувача. У наведеній нижче таблиці описано деякі основні параметри. 

Параметр Опис 

TLS/SSL 

Якщо цю функцію ввімкнено, електронні листи шифруватимуться по протоколу TLS 
(безпека транспортного рівня) або SSL (протокол захищених сокетів) для забезпечення 
конфіденційності. 

Спочатку система спробує вконати відправку по протоколу SSL. Якщо сервер SMTP 
підтримує SSL, електронний лист буде надіслано по SSL, інакше використовуватиметься 
протокол STARTTLS. 

Прикріпити 
зображення 

Якщо цю функцію ввімкнено, до електронного листа додається 3 знімка у відповіднсті з 
періодом зйомки. 

Ім'я 
користувача/пароль 

Ім'я користувача і пароль для адреси електронної пошти, які ви вказали під час реєстрації. 
У паролі допустимі такі спеціальні символи:: \ / : * ? ’ ” <> | % & 

 

3. Натисніть кнопку Save для збереження. 

Перемикання портів 

1. Натисніть Setup > Network > Port. Перейдіть на вкладку Port Mapping. 
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2. Активуйте Port Mapping і виберіть тип відображення. Якщо вибрана опція Manual, тоді мають бути 
задані зовнішні порти (зовнішня IP-адреса отримується камерою автоматично). Якщо вибраний 
порт зайнятий, стан (Status) буде відображатися як неактивний. 

3. Натисніть кнопку Save для збереження. 

DNS 

1. Натисніть Setup > Network > DNS. 

 

2. Вкажіть адресу сервера DNS. 

3. Натисніть кнопку Save для збереження. 

DDNS 

 ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для з’ясування подробиць див. фактичну 
модель. 

 

1. Натисніть Setup > Network > DDNS. 

 
2. Активуйте службу DDNS Service. 

3. Виберіть тип DDNS: DynDNS, NO-IP або EZDDNS. 

4. Задайте інші параметри, включаючи адресу сервера, доменне ім'я, ім'я користувача і пароль. 

5. Натисніть кнопку Save для збереження. 
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EZCloud 

 ПРИМІТКА! 
 Ця функція не підтримується деякими моделями. 
 Щоб завантажити додаток, відскануйте QR-код за допомогою мобільного телефону (iOS або 

Android). 
 Після встановлення запустіть програму, щоб додати камеру. Детальну послідовність дій 

дивіться в онлайн-керівництві програми. 

 

1. Натисніть Setup>Network>EZ Cloud. 

 

2. Для активації хмарного сервісу виберіть On. 

3. Натисніть кнопку Save для збереження. 

 

SNMP 

Якщо камера повинна передавати конфігурацію на центральний сервер, рекомендується 
використовувати SNMPv3. І камера, і центральний сервер повинні підтримувати SNMPv3. 

 ПРИМІТКА! 
 Доступні два варіанти: SNMPv3 (за замовчуванням) і SNMPv2. 
 При виборі SNMPv2 на екрані з'явиться повідомлення з нагадуванням про потенційні ризики 

і запитом, чи хочете ви продовжити. 
 

1. Натисніть Setup> Network > SNMP 
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2. Виберіть SNMPv3 і завершіть налаштування. 

3. Натисніть кнопку Save для збереження. 

На сторінці налаштувань SNMPv2 Read-Only Community Name використовується для двосторонньої 
автентифікації між камерою та центральним сервером. Ім'я за замовчуванням — public. При 
необхідності його можна змінити. Коли ви змінюєте ім'я Read-Only Community Name його також слід 
змінити на аналогічне на центральному сервері, інакше двостороння автентифікація не буде 
виконана. 

 

 

802.1x 

802.1x забезпечує автентифікацію пристроїв (наприклад, камер), які намагаються підключитися до 
мережі. До мережі можуть підключатися лише пристрої що пройшли автентифікацію. Це підвищує 
рівень безпеки. 

1. Натисніть Setup > Network > 802.1x. 

 
2. Виберіть On, а потім виконайте інші налаштування. 

3. Натисніть кнопку Save для збереження. 

QoS 

QoS (якість обслуговування) - це можливість забезпечити найкраще обслуговування для вказаної 

мережевої передачі інформації. Як механізм мережевої безпеки QoS використовується для вирішення 

таких проблем як затримка і блокування сигналу в мережі. Коли мережа перевантажена або 

переповнена, QoS забезпечує відсутність затримок, скидання критичних служб і ефективну роботу 

мережі. 

1. Натисніть Setup > Network > QoS. 
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2. Встановіть рівень пріоритету (0–63) для кожної служби. В даний час QoS дозволяє призначати різні 

рівні пріоритету для аудіо і відео, сигналів тривоги, управління конфігурацією і передачі по FTP. 
Чим вище значення, тим вище пріоритет. Наприклад, якщо встановлено значення 60 для аудіо та 
відео, 0 для сигналів тривоги і керування конфігурацією, а для FTP - 4, у разі перевантаження 
мережі пріоритет матиме плавне відтворення аудіо і відео. 

3. Натисніть кнопку Save для збереження. 

 
Примітка.  

Для використання QoS переконайтеся, що комутатор підтримує режим QoS. 

 

 

 

Налаштування зображення 

Налаштування параметрів зображення 

 ПРИМІТКА! 
 Відображувані параметри зображення і діапазони допустимих значень залежать від моделі 

камери. Щоб дізнатися фактичні параметри і діапазони значень для вашої камери, див. веб-
інтерфейс. Щоб змінити налаштування, ви можете переміщати повзунки або вводити 
значення безпосередньо в текстові вікна. 

 Натискання кнопки Default скине всі налаштування зображення до значень за 
замовчуванням. 

 

Параметри сцени 

Задайте параметри зображення, щоб досягти бажаних ефектів для живого відео в різних сценах. 

Натисніть Setup > Image > Image. 

Сторінка керування сценою для деяких моделей показана нижче. Ви можете обрати бажану сцену з 
випадаючого списку. 

 

Нижче наведено сторінку керування сценою для деяких інших моделей. Тут ви можете виконати 
наведені нижче дії, щоб налаштувати сцену. 
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1. Натисніть Scenes. 

2. Виберіть сцену, а потім встановіть параметри перемикання сцен. У таблиці нижче описано деякі 
основні параметри. 

Стовпчик Опис 

Поточна 

Вказує сцену, яка зараз використовується. 

Примітка.  
 Натисніть кнопку вибору, щоб вибрати сцену і відкрити відповідні параметри 

зображення для неї. 
 Якщо вибрана опція Enable Auto Switching, камера перемикає поточну сцену 

автоматично. 

Назва сцени 

Назва поточної сцени. Пристрій підтримує кілька попередньо встановлених режимів 
сцени. Коли ви вибираєте сцену, відображаються відповідні параметри зображення. Ви 
можете скоригувати налаштування зображення відповідно до фактичних потреб. 

 Загальний: рекомендується для сцен на відкритому повітрі. 
 Внутрішній: рекомендується для сцен у приміщенні. 
 Висока чутливість: рекомендується для умов слабкого освітлення. 
 Компенсація засвічування: здатна нівелювати яскраве світло, наприклад, від 

автомобільних фар на дорогах і від прожекторів у парках. Рекомендується для 
зйомки номерних знаків автомобілів. 

 Широкий динамічний діапазон (WDR): рекомендується для сцен із 
висококонтрастним освітленням, таких як вікна, коридор, вхідні двері або інших 
сцен, які яскраво освітлені зовні, але затемнені всередині. 

 Користувацький: вкажіть необхідне ім'я сцени. 
 Обличчя: зйомка облич в русі у складних сценах. 

Автоматичне 
перемикання 

Вказує, чи потрібно додавати сцену до списку автоматичного перемикання. 

Примітка.  
Якщо вибрано режим Auto Switching, система автоматично переходить до сцени, коли 
виконуються умови перемикання сцени. За замовчуванням список автоматичного 
перемикання сключає сцену заводських налаштувань. 

Умови 

Натисніть , , щоб встановити умови автоматичного перемикання, включаючи 
розклад, освітлення і поточний кут нахилу (кут між PTZ і горизонтальною площиною). Це 
означає, що автоматичне перемикання спрацьовує тільки тоді, коли освітлення і 
поточний кут нахилу в заданий період часу задовольняють вказаним умовам. Ця умова 
недійсна, якщо початкове і кінцеве значення встановлені на 0. 

3. Виберіть сцену і потім клацніть , щоб задати її як сцену за замовчуванням. 
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4. Якщо вибрано режим автоматичного перемикання, система автоматично перейде до сцени, якщо 
виконуються умови перемикання на сцену, відмінну від сцени за замовчуванням. В іншому 
випадку камера продовжить використовувати сцену за замовчуванням. Коли автоматичне 
перемикання не активовано, камера працює з поточною сценою. 

 ПРИМІТКА! 
 Якщо автоматичне перемикання активовано (налаштування сцени будуть недоступні), 

пристрій буде перемикатися між заданими сценами. В іншому випадку пристрій залишиться 
в режимі поточної сцени. Пристрій використовуватиме сцени за замовчуванням, якщо інші 
сцени не будуть активовані. 

 Якщо буде активовано кілька сцен, відмінних від сцен за замовчуванням, пристрій вибере 
сцену з найменшим номером (від 1 до 5). 

 

Покращення зображення 

 ПРИМІТКА! 
Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 
фактичний веб-інтерфейс.  

1. Натисніть Setup > Image > Image, а потім виберіть Image Enhancement. 

 
2. Щоб змінити налаштування, скористайтеся повзунками. Ви також можете ввести значення 

безпосередньо. У таблиці нижче описано деякі основні параметри. 

Компонент Опис 

Яскравість 

Налаштування яскравості зображення. 

  

Низька яскравість Висока яскравість 
 

Насиченість 

Відтінок кольору. 

  

Низька насиченість Висока насиченість 
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Компонент Опис 

Контрастність 

Встановіть ступінь різниці між самим чорним і самим білим пікселями. 

  

Низька контрастність Висока 
контрастність 

 

Різкість 

Контрастність меж об'єктів на зображенні. 

  

Низька різкість Висока різкість 
 

2D-зменшення 
шуму Зниження рівня шуму зображень. Ця функція може призвести до розмиття зображення. 

3D-зменшення 
шуму 

Зниження рівня шуму зображень. Ця функція може призвести до розмиття зображення 
рухомого об'єкта (або його роздвоєння у деяких випадках). 

Поворот 
зображення 

Поворот зображення.  

  

Звичайний запис Перевернути по вертикалі 

  

Перевернути по горизонталі 180° 
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Компонент Опис 

  

Поворот на 90° за годинниковою 
стрілкою 

Поворот на 90° проти годинникової 
стрілки 

 

 

3. Щоб відновити налаштування за замовчуванням у цій області, натисніть Default. 

Експозиція 

 ПРИМІТКА! 
 Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації 

див. фактичний веб-інтерфейс. 
 Налаштування за замовчуванням залежать від сцени. Використовуйте налаштування за 

замовчуванням, коли зміни не потрібні. 

 

1. Натисніть Setup > Image > Image, а потім виберіть Exposure. 

 
Для деяких моделей камер сторінка відображається наступним чином. 
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2. Змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні 
параметри. 

Параметр Опис 

Режим експозиції 

Виберіть потрібний режим експозиції для досягнення бажаного ефекту. 

 Авто: камера автоматично регулює витримку відповідно до стану навколишнього 
середовища. 

 Користувацький: користувач встановлює витримку відповідно до своїх вимог. 
 У приміщенні, 50 Гц: зменшення кількості смуг, за рахунок обмеження частоти 

спрацювання затвора. 
 У приміщенні, 60 Гц: зменшення кількості смуг, за рахунок обмеження частоти 

спрацювання затвора. 
 Вручну: точне налаштування якості зображення за допомогою ручного регулювання 

затвора, підсилення і діафрагми. 
 Низьке розмиття зображення рухомого об'єкта: регулювання мінімального часу 

спуску затвора, щоб зменшити розмитість зображень облич, знятих під час руху. 

Затвор 

Для управління світлом, що надходить в об’єктив, використовується затвор. Висока 
швидкість затвору підходить для швидкої зміни кадрів, а низька швидкість — для 
повільної. 

Примітка.  
 Ви можете встановити швидкість затвору, коли для параметра Exposure Mode 

встановлено значення Manual або Shutter Priority.  
 Якщо для параметра Slow Shutter встановлено значення Off, зворотня величина 

щвидкості затвору має бути більше частоти кадрів. 

Посилення (дБ) 

Налаштовуйте сигнали зображення так, щоб на виході камери були стандартні 
відеосигнали, які відповідають рівню освітленості. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Exposure Mode 
встановлено значення Manual або Gain Priority. 

Повільний затвор 

Покращення яскравості зображення в умовах слабкого освітлення. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Exposure Mode 
не встановлено значення Shutter Priority, а функція Image Stabilizer відключена. 
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Параметр Опис 

Сама повільна 
швидкість затвору 

Встановіть саму повільну швидкість затвора, яку камера може використовувати під час 
експозиції. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Slow Shutter 
встановлено значення On. 

Компенсація 

Задайте значення компенсації, щоб досягти бажаних ефектів. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Exposure Mode 
не встановлено значення Manual. 

Контроль виміру 

Оберіть спосіб вимірювання інтенсивності освітлення камерою. 

 Центрозважений средній замір: інтенсивність освітлення вимірюється переважно в 
центральній частині зображень. 

 Оціночний замір: інтенсивність освітлення вимірюється в заданій області 
зображення. 

 Компенсація підсвічування: яскравість перетриманих областей зображень 
ігнорується. Однак вибір цієї опції зменшить загальну яскравість зображення. 

 Замір по обличчю: корекція якості зображення при слабкому освітленні і контролі 
яскравості обличчя в сцені Face (Обличчя). 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Exposure Mode 
не встановлено значення Manual. 

Режим день/ 
ніч 

 Авто: камера виводить оптимальне зображення відповідно до рівня освітленості. У 
цьому режимі камера може автоматично перемикатися між денним і нічним 
режимами. 

 Ніч: камера забезпечує якісне чорно-біле зображення при існуючому освітленні 
 День: камера забезпечує якісне кольорове зображення при існуючому освітленні. 

Чутливість в 
режимах дня і 
ночі 

Поріг освітленості при перемиканні між денним і нічним режимами. Висока чутливість 
означає, що камера чутливіша до зміни освітленості та легше перемикається між 
режимами дня і ночі. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Day/Night Mode 
встановлено значення Automatic. 

Перемикання між 
режимами дня і 
ночі 

Встановіть затримку перед перемиканням між денним і нічним режимами після 
виконання умови перемикання. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Day/Night Mode 
встановлено значення Automatic. 

WDR 

Увімкніть функцію WDR (широкий динамічний діапазон), щоб розрізняти світлі та темні 
області на одному зображенні. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Exposure Mode 
не задано значення Customize і Manual, а функція Image Stabilizer відключена. 
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Параметр Опис 

Рівень 
динамічного 
діапазону 

Після вмикання функції WDR ви можете покращити зображення, коригуючи рівень 
динамічного діапазону. 

Примітка.  
У разі високої контрастності між світлими і темними областями сцени використовуйте 
рівень 7 або вище. При низькій контрастності рекомендується відключити WDR або 
використовувати рівні 1-6. 

Усунення WDR 
смуг 

При увімкненні цієї функції камера може автоматично коригувати частоту повільного 
затвора у відповідності до частоти світла, щоб мінімізувати смуги, які можуть з'явитися 
на зображенні. 

 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 

Розумне підсвічування 

 ПРИМІТКА! 
Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 
фактичний веб-інтерфейс.  

 

1. НатиснітьSetup > Image > Image, а потім виберіть Smart Illumination. 

 

2. Виберіть відповідний режим управління ІЧ-підсвічуванням і встановіть параметри. У таблиці 
нижче описано деякі основні параметри. 

Параметр Опис 

Тип освітлення 

 Інфрачервоний: камера використовує інфрачервоне підсвічування. 
 Біле світло: Камера використовує підсвічування білим світлом. 
Примітка.  
Коли для параметра Control Mode встановлено значення Manual, для камери можна 
встановити рівні освітленості від 0 до 1000. 

Режим 
управління 

 Глобальний режим: камера регулює рівень ІЧ-освітлення і витримку, щоб 
забезпечити збалансовані ефекти передачі зображення. Якщо вибрано цю опцію, 
деякі ділянки зображення можуть бути перетримані. Рекомендується 
використовувати цю опцію, якщо вашим першочерговим завданням є забезпечення 
контрольованого діапазону яскравості зображень. 

 Обмеження перетримки: камера регулює рівень ІЧ-освітлення і витримку, щоб 
запобігти перетриманню деяких областей зображень. Якщо вибрано цю опцію, деякі 
області зображення можуть виглядати чорними. Рекомендується використовувати цю 
опцію, якщо вашим першочерговим завданням є забезпечення чіткості центральної 
частини зображення і контроль перетримки. 

 Дорога: ця опція забезпечує яскраве освітлення у повній зоні огляду. Вона 
рекомендується для контролю широких сцен, наприклад, дороги. 

 Парк: ця опція забезпечує рівномірне освітлення. Вона рекомендується для контролю 
невеликих сцен з багатьма перешкодами, наприклад, технопарків. 

 Вручну: ця опція дозволяє вручну регулювати інтенсивність ІЧ-підсвічування. 
 Всередині: цю опцію рекомендується використовувати у внутрішніх сценах. 
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Рівень 
освітлення 

Встановіть рівень яскравості ІЧ-підсвічування. Чим вище значення, тим вище 
інтенсивність. Значення 0 означає, що ІЧ-підсвічування вимкнуто. 

 Рівень ближньго освітлення: рекомендується встановити цей параметр для 
ширококутної сцени. 

 Рівень проміжного освітлення: рекомендується встановити цей параметр, якщо 
сцена вимагає проміжної фокусної відстані. 

 Рівень дальнього освітлення: рекомендується встановити цей параметр, якщо для 
перегляду сцени потрібен телеоб'єктив. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Control Mode 
встановлено значення Manual. 

 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 

Фокус  

 ПРИМІТКА! 
Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 
фактичну модель.  

 

1. Натисніть Setup > Image > Image, а потім виберіть Focus. 

 

2. Оберіть необхідний режим фокусування. 

Параметр Опис 

Режим 
фокусування 

 Автофокус: камера автоматично фокусується відповідно до поточної освітленості. 
 Ручний фокус: ручне фокусування камери. 
 Фокусування одним клацанням: камера фокусується один раз під час обертання, 

зміни масштабування або вмиканні пресету. 
 Фокусування одним клацанням (ІЧ): при слабкому освітленні, наприклад, у вечірні 

години або в темному будинку, цей метод фокусування забезпечує кращі результати 
з увімкненим ІЧ-підсвічуванням. 

Сцена 

 Звичайний запис: використовується для звичайних сцен, таких як дороги і технопарки. 
 Велика відстань: використовується для дальнього моніторингу на дорозі. Наприклад, 

коли камера встановлена на висоті понад 30 м для контролю віддаленого дорожнього 
перехрестя. 

 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 

Баланс білого 

Баланс білого - це процес корекції неприродних колірних відтінків з різною колірною температурою, 
для створення зображення, яке найкраще сприймається людським оком. 

 ПРИМІТКА! 
Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 
фактичний веб-інтерфейс. 
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1. Натисніть Setup > Image > Image, а потім виберіть White Balance. 

 
2. Виберіть необхідний режим балансу білого. У таблиці нижче описано деякі основні параметри. 

Параметр Опис 

Баланс білого 

Налаштування червоного або синього зміщення в зображенні:  

 Авто/Авто2: камера автоматично регулює червоне і синє зміщення відповідно до 
рівня освітленості (є тенденція зміщення до синьої частини спектру). Якщо 
зображення все одно лишається неприродно червоним або синім в режимі Auto, 
спробуйте режим Auto2. 

 Точне налаштування: дозволяє коригувати червоне і синє зміщення вручну. 
 Зовні: опція для відкритого середовища з відносно широким діапазоном колірних 

температур. 
 Заблоковано: блокування поточної колірної температури без можливості зміни. 
 Натрієва лампа: камера автоматично регулює червоне і синє зміщення відповідно до 

рівня освітленості (є тенденція зміщення до червоної частини спектра). 

Червоне 
зміщення 

Ручна корекція червоного зміщення. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра White Balance 
встановлено значення Fine Tune. 

Синє зміщення 

Ручна корекція синього зміщення. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра White Balance 
встановлено значення Fine Tune. 

 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 

Додатково 

Використовуйте функцію «Антитуман» для коригування чіткості зображень, отриманих у тумані або 
атмосферній імлі. 
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1. Натисніть Setup > Image > Image, а потім виберіть Advanced. 

 

 ПРИМІТКА! 
 Ви можете налаштувати цей параметр тільки тоді, коли функція WDR відключена. 
 Деякі моделі камер підтримують функцію оптичного антитуману. Коли для параметра Defog 

встановлено значення On, рівні інтенсивності 6-9 відповідають оптичному антитуману. Коли 
інтенсивність антитуману встановлена на рівень 5 або 6, зображення перемикається з 
кольорового на чорно-біле. Коли для параметра Defog встановлено значення Auto, а 
інтенсивність антитуману знаходиться між рівнями 6-9, зображення не стає автоматично 
чорно-білим в умовах легкого туману. Камера автоматично переходить в режим оптичного 
антитуману тільки в умовах густого туману. 

 

2. Увімкніть функцію антитуману, а потім виберіть рівень  для сцени. Рівень 9 відповідає 
максимальному ефекту антитуману, а рівень 1 - мінімальному. 

  
Функція антитуману вимкнена Функція антитуману ввімкнена 

 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 

Тип освітлення 

 ПРИМІТКА! 
Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 
фактичну модель.  

 

1. Натисніть Setup > Image > Image, а потім виберіть Smart Illumination. 

 

2. Виберіть опцію з випадаючого списку Lighting Type. 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 
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Вибір режиму діафрагми і об’єктива 

 ПРИМІТКА! 
 Ця функція підтримується лише певними типами корпусних IP-камер. Для отримання 

детальної інформації див. фактичну модель.. 
 Використовуйте об'єктив із режимом керування Р-діафрагмою і підключіть кабель керування 

діафрагмою до порту Z/F камери. 
 Діафрагму можна налаштувати лише тоді, коли для параметра Lens Mode встановлено 

значення P-IRIS. 

 

1. Натисніть Setup > Image > Image, а потім виберіть Advanced. 

 

2. Змініть налаштування відповідно до ваших потреб. У наведеній нижче таблиці описано деякі 
основні параметри. 

Параметр Опис 

Режим 
об'єктива 

 Z/F: зміна фокусу і зуму. 
 P-Iris: зміна значення діафрагми. 

Управління 
діафрагмою 

Налаштуйте діафрагму автоматично або вручну. 
Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Lens Mode 
встановлено значення P-Iris. 

F-число Зміна діафрагми вручну. 

 

3. Щоб відновити налаштування за замовчуванням, натисніть Default. 

Налаштування екранного інтерфейсу 

Екранний інтерфейс (OSD) включає текст, відеозображення і елементи, які може вибрати користувач, 
наприклад час, тощо. 

 ПРИМІТКА! 
Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 
фактичний веб-інтерфейс. 
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1. Натисніть Setup > Image > OSD. 

 

Нижче показаний інтерфейс, що відображається на деяких моделях. 

 

2. Виберіть вміст екранного інтерфейсу і місце його розташування на екрані. 

 Місце розташування: клацніть потрібне поле в області Live View. Після зміни форми курсору 
натисніть і  утримуйте ліву кнопку миші, щоб перетягнути поле в потрібне положення. Щоб точно 
встановити розташування, використовуйте координати X та Y в області Overlay Area. 

 Накладення вмісту екранного інтерфейсу: випадаючий список містить наступні пункти: Time, 
Preset і Serial Info. Ви також можете вибрати Custom і ввести свій контент. 

 Після налаштування вмісту екранного інтерфейсу і його розташування в колонці Status з'являється 
символ . Це означає, що екранний інтерфейс успішно налаштований. Можна створити кілька 
рядків вмісту для кожної області та скористатися клавішами  і  для вибору послідовності 
відображення. 
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3. Після виконання налаштування з’явиться повідомлення про успішне завершення цієї операції. 

Ви можете клацнути правою кнопкою миші у вікні попереднього перегляду та вибрати перегляд у 
повноекранному режимі або в іншому форматі. Ви також можете двічі клацнути у вікні попереднього 
перегляду, щоб увійти в повноекранний формат або вийти з нього. 

Щоб скасувати екранний інтерфейс для області, видаліть його вміст у стовпці Overlay OSD Content або 
виберіть None в стовпці Position. 

Нижче наведено приклад накладання часу. 

 

Режим маскування 

У деяких випадках може знадобитися встановити замасковану область на зображенні камери для 
забезпечення конфіденційності, наприклад, у області клавіатури банкомату. При зміні напрямку 
перегляду або масштабуванні зображення, маска конфіденційності повинна зміщатися належним 
чином, щоб завжди захищати задану область. 

 ПРИМІТКА! 
 Ця функція може змінюватися в залежності від моделі. Для отримання детальної інформації див. 

фактичний веб-інтерфейс.  
 Деякі моделі підтримують до 24 масок конфіденційності. На одному зображенні відображається 

лише до 8 масок конфіденційності. 
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1. Натисніть Setup > Image > Privacy Mask. 

 
У деяких моделях камер відображається наступна сторінка:  

 
2. Щоб додати маску конфіденційності, натисніть . Щоб видалити маску, натисніть . 
 Маскування позиції: клацніть поле, де відображається маска (Mask), щоб активувати її. Після зміни 

форми курсору перетягніть поле в потрібне положення. 

 Маскування області: використовуючи мишу намалюйте поле в області, яку потрібно замаскувати. 

Якщо маску конфіденційності налаштовано, потрібна область буде заблокована. Наступні ілюстрації 
наведено для прикладу. 
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3. Виберіть режим маскування. По необхідності можна обрати стандартний і нестандартний режим. 
У нестандартному режимі при повороті камери PTZ форма маски конфіденційності змінюється 
разом з формою замаскованого об'єкта на зображенні. 

 

 ПРИМІТКА! 
 Режим маскування доступний лише для певних моделей. 

 

Налаштування аудіо і відео 

Конфігурація відео 

Ви можете встановити параметри відео, які підтримує ваша камера, і переглянути поточний стан 
виходу BNC. За необхідності можна також включити додатковий потік і третій потік, якщо ці функції 
підтримуються камерою. 

 

ПРИМІТКА! 
 Ця функція може змінюватися в залежності від моделі. Не всі моделі камер підтримують третій потік. 

Щоб дізнатися, чи підтримує ваша камера цю функцію, див. веб-інтерфейс. 
 Після включення додаткового або третього потоку, змініть параметри відповідним чином. 

Параметри для вторинного і третього потоку мають ті ж значення, що і для основного потоку. 
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1. Натисніть Setup > Video & Audio > Video. 

 

2. Змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні 
параметри. 

Параметр Опис 

Стиснення відео 

Три опції: H.265, H.264 і MJPEG. 
Примітка.  

 Якість зображення не можна налаштувати, коли для стиснення відео встановлено 
опції H.265 або H.264. При виборі опції MJPEG доступні лише три частоти кадрів: 1, 
3 і 5; при цьому значения швидкості потоку, інтервалу I-кадрів, плавності та U-коду 
не можуть бути задані. 

 При перемиканні між H.264 і H.265 для швидкості потоку встановлюється значення 
за замовчуванням. Швидкість потоку за замовчуванням для H.265 в два раза менше, 
ніж для H.264. 

Частота кадрів 

Частота кадрів для кодування зображень. од. вим.: к/сек. (кадр в секунду). 

Примітка.  
Щоб забезпечити високу якість зображення, зверніть увагу на те,  що частота кадрів не 
повинна бути більше, ніж зворотня величина швидкості затвора. 

Тип швидкості 
потоку 

 CBR: постійна швидкість потоку. Це означає, що камера передає дані з постійною 
швидкістю. 

 VBR: змінна швидкість потоку. Це означає, що камера динамічно регулює швидкість 
передачі даних відповідно до якості зображення. 

Якість 
зображення 

Коли для параметра Encoding Mode встановлено значення VBR, ви можете регулювати 
якість зображення, преміщуючи повзунок. Переміщення повзунка убік Bit Rate знижує 
швидкість потоку, але може негативно вплинути на якість зображення. Переміщення 
повзунка убік Quality збільшує швидкість потоку і покращує якість зображення. 
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Параметр Опис 

Інтервал I-кадрів Інтервал кодування I-кадрів. Як правило, більш короткий інтервал I-кадрів забезпечує 
кращу якість зображення, але вимагає більшої пропускної здатності. 

GOP Група зображень з кодуванням MPEG. Цей параметр визначає порядок послідовності 
слідування інтра-кадрів (кадрів з внутрішнім кодуванням, I-кадрів) та інтер-кадрів. 

SVC Функція SVC (масштабоване кодування відео) допомагає зменшити обсяг даних, що 
зберігаються, без зниження якості відтворення. 

U-код 

 Стандартний режим: фактична швидкість потоку становить 3/4 від заданої 
швидкості. 

 Розширений режим: фактична швидкість потоку становить 1/2 від заданої 
швидкості. 

Примітка.  
 Коли U-код активований, стиснення відео підтримується лише у форматах H.264 і 

H.265. Формат MJPEG не підтримується. 
 Коли U-код активований, режим зйомки не підтримує частоту кадрів вищу 

30 к/сек. 

Плавність 

Встановіть ступінь плавності. При виборі Clear функція плавності Smoothing 
відключається. Переміщення повзунка убік Smooth підвищує рівень плавності, але 
може негативно вплинути на якість зображення. 

Примітка.  
У ненадійному мережевому середовищі ви можете ввімкнути функцію плавності для 
отримання більш рівномірного відео. 

Вихід BNC Вихід BNC підтримує формати NTSC і PAL. 

 

3. Натисніть кнопку Save для збереження. 

Налаштування аудіоканалу 

Налаштування аудіоканалу передбачає налаштування параметрів кодування звуку для камери. 

 

ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. фактичну 
модель. 

 

1. Натисніть Setup > Video & Audio > Audio. 

 
2. Змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні 

параметри. 



35 

Параметр Опис 

Аудіовхід 

Якщо вибрано значення Off, аудіодані не будуть кодуватися. 

Примітка.  
Якщо вам не потрібен звуковий супровід, рекомендується вибрати Off. Це може дещо 
поліпшити продуктивність пристрою. 

Режим доступу 

На даний час доступні тільки дві опції: Line/Mic (лінійний вхід/мікрофон). 

Примітка.  

Ця функція недоступна на пристроях з двома аудіовиходами. 

Стиснення аудіо 
Три опції: G.711U, G.711A і ACC-LC.  

G.711U і G.711A підтримують лише частоту дискретизації 8 кГц, а ACC-LC підтримує 
частоти 8, 16 і 48 кГц. 

Вхідне 
посилення 

Посилення аудіосигналу для дискретизації. Чим більше посилення, тим сильніше 
збільшення. 

Шумозаглушення Використовується для зменшення шуму. Щоб увімкнути заглушення шуму, виберіть On. 

Канал 

Канал аудіовиходу. Щоб увімкнути аудіовихід, виберіть Enable. 

Примітка.  

Не всі моделі камер підтримують два канали. 

 

3. Натисніть кнопку Save для збереження. 

Створення знімків. 

1. Натисніть Setup > Video & Audio > Snapshot. 

 
2. Виберіть On, а потім виберіть роздільну здатність, максимальний розмір і розклад відповідно до 

ваших потреб. Опис деяких параметрів наведено нижче. 
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Параметр Опис 

Інтервал між 
знімками 

Інтервал між двома знімками. Наприклад, якщо інтервал між знімками 
встановлено на 1, а кількість знімків встановлено на 2, камера зробить 2 знімки 
(спершу один, і через 1 секунду - другий). 

Кількість знімків В даний час допустима кількість знімків становить 1, 2 і 3. 

Режим скріншотів 

Графік: необхідно встановити час, коли повинен бути зроблений знімок, 
наприклад 19:12:00, це означає, що камера зробить знімок в 19:12:00. 

Повтор: дозволяє встановлювати інтервал (одиниць/сек). Наприклад, згідно з 
налаштуваннями на зображенні вище, перш ніж камера зробить ще два знімки, 
має пройти 60 секунд,. 

 

3. Натисніть кнопку Save для збереження. 

ROI 

Коли ввімкнено функцію області інтересу (ROI), а швидкість потоку обмежена, система спочатку 
забезпечує хорошу якість зображення для ROI. 

 

ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 

1. Натисніть Setup > Video & Audio > ROI. 

 

2. Натисніть , а потім скористайтеся перетягуванням мишею для покриття заданої частини 

зображення. Для видалення виберіть область, а потім натисніть . 

Налаштування потоку медіаданих 

Потік медіаданих 

Ви можете відображати встановлені потоки медіаданих з камери. Ви також можете налаштувати 
камеру таким чином, щоб вона передавала кодовані потоки по протоколу UDP або TCP на вказану IP-
адресу і номер порту. Налаштування можна зберегти. Вони вступлять в силу після перезапуску камери. 
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ПРИМІТКА! 
 Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 

фактичну модель. 
 Виберіть транспортний протокол, виходячи з ваших фактичних потреб і продуктивності 

мережі. Простіше кажучи, TCP забезпечує кращу якість зображення, ніж UDP, але збільшує час 
очікування. 

 

1. Натисніть Setup > Video & Audio > Media Stream. 

 

2. Натисніть , виберіть тип потоку, а потім задайте IP-адресу і номер порту одноадресної або 

багатоадресної групи для пристрою декодування, який приймає аудіо- та відеопотоки від камери. 

Якщо ви хочете, щоб пристрій вибрав потік медіаданих, який був заданий до автоматичного 
налаштування після перезавантаження пристрою, виберіть для параметра Persistent значення Yes. 

3. Для видалення потоку натисніть . 
4. Натисніть Submit для завершення операцій. 

Адреса RTSP Multicast  

Після установки адреси RTSP Multicast програвач стороннього виробника може затребувати 
багатоадресний потік RTSP з камери по протоколу RTP. 
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1. Натисніть Setup > Video & Audio > Media Stream > RTSP Multicast Address. 

 
Для деяких моделей камер сторінка відображається наступним чином. 

 

2. Задайте адресу багатоадресної передачі (від 224.0.0.0 до 239.255.255.255) і номер порту (від 0 до 
65 535). 

3. Натисніть кнопку Save для збереження. 
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Налаштування розумної сигналізації 

Ви можете налаштувати інтелектуальний моніторинг з підрахунком кількості людей і відстеженням 
об'єктів, що рухаються. Інтелектуальний моніторинг включає підрахунок відвідувачів, виявлення 
вторгнень і автоматичне відстеження об'єктів. 

Підтримувані функції залежать від моделі камери. 

Розумні налаштування 

Натисніть Setup > Intelligent > Smart Settings. 

 

Для деяких моделей камер сторінка відображається наступним чином. 

 

Виявлення перетину лінії 

Функція виявлення перетину лінії виявляє об'єкти, які перетинають віртуальну лінію в режимі живого 
відео. При виявленні такої події спрацьовує сигналізація. 
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1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Cross Line і натисніть . 

 

2. Виберіть Cross Line Detection. 

3. У розділі Detection Rule натисніть  , щоб додати нову область виявлення. Для видалення 

області виявлення натисніть . 
4. У маленькому вікні попереднього перегляду протягніть лінію до наміченої позиції і задайте 

діапазон виявлення. 

5. Задайте напрям і чутливість, при якій камера має сигналізувати про перетин лінії. 

6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

7. Натисніть кнопку Save для збереження. 

Виявлення вторгнень 

Функція виявлення вторгнень виявляє об'єкти, що потрапляють в задану область, в режимі живого 
відео. При виявленні такої події спрацьовує сигналізація. 
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1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Intrusion і натисніть . 

 

2. Виберіть Intrusion Detection. 

3. У розділі Detection Rule натисніть  щоб додати нову область виявлення. Для видалення області 

виявлення натисніть . 
4. Встановіть потрібні позиції і діапазон шляхом перетягування меж поля. 

5. Встановіть поріг часу, чутливість і відсотковий коефіцієнт, при яких камера повинна сигналізувати 
про виявлення вторгнення. 

 Поріг часу: мінімальний відрізок часу, протягом якого порушник може перебувати в зоні 
виявлення до спрацьовування сигналізації. 

 Чутливість: чутливість виявлення. Чим вище значення, тим більше чутливість виявлення. 

 Відсоткове співвідношення: мінімальне відношення розміру зловмисника до розміру заданої 
зони виявлення, при якому спрацьовує сигналізація. 

6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

7. Натисніть кнопку Save для збереження. 

Рухомий об'єкт 

Виявлення об'єктів, що залишилися в зазначеній області, і запуск сигналізації. 
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1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Object Moving і натисніть . 

 
2. Виберіть Enable Object Moving Detection. 

3. У розділі Detection Rule натисніть  щоб додати область виявлення. Для видалення області 

виявлення натисніть . 
4. Встановіть позиції і робочий діапазон, перетягнувши рамку. 

5. Встановіть поріг часу та чутливість, при яких камера має сигналізувати про виявлення вторгнень. 

 Поріг часу: мінімальний проміжок часу, протягом якого об'єкт повинен бути виявлений у 
зазначеній області для спрацьовування сигналізації. 

 Чутливість: чим вище значення, тим вище чутливість. Сигнал тривоги спрацьовує, якщо об'єкт 
виявлений в зазначеній області протягом вказаного проміжку часу. 

6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

7. Натисніть кнопку Save для збереження. 

Залишений об'єкт 

Виявлення об'єктів, що залишилися в зазначеній області, і запуск сигналізації. 
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1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Object Left і натисніть . 

 
2. Виберіть Enable Object Left Detection. 

3. У розділі Detection Rule натисніть  щоб додати область виявлення. Для видалення натисніть 

. 
4. Встановіть позиції і робочий діапазон, перетягнувши рамку. 

5. Встановіть поріг часу та чутливість, при яких камера має сигналізувати про виявлення вторгнень. 

 Поріг часу: мінімальний проміжок часу, протягом якого об'єкт повинен бути виявлений у 
зазначеній області для спрацьовування сигналізації. 

 Чутливість: чим вище значення, тим вище чутливість. Сигнал тривоги спрацьовує, якщо об'єкт 
виявлений в зазначеній області протягом вказаного проміжку часу. 

6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

7. Натисніть кнопку Save для збереження. 

Виявлення облич 

Функція розпізнавання облич виявляє обличчя людей у режимі живого відео. 
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1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Face і натисніть . 

 
2. Встановіть потрібні позиції і діапазон шляхом перетягування меж. 

3. Налаштуйте параметри виявлення відповідно до фактичних потреб. 

4. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

5. Натисніть кнопку Save для збереження. 

6. Натисніть Start Intelligent Analysis. 

Підрахунок людей 

 

ПРИМІТКА! 
 Не всі моделі камер підтримують цю функцію. 
 Підтримувані функції спрацювання сигналізації і розкладу постановки на охорону залежать 

від конкретної моделі камери. Для отримання детальної інформації див. фактичний веб-
інтерфейс. 

 

1. Натисніть Setup > Intelligent > Smart Settings. Виберіть People Counting і натисніть . 
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2. Виберіть Enable Passenger Flow Detection. Виберіть спосіб виявлення, встановіть інтервал 

відправки сигналу і чутливість. 

3. Натисніть Draw Detection Area, а потім намалюйте область виявлення (наприклад, квадрат) у вікні 
попереднього перегляду ліворуч. 

4. Натисніть Draw Entrance Direction, а потім позначте напрямок у вікні попереднього перегляду 
ліворуч. Напрямок зазвичай буває вертикальним або під нахилом. 

5. У розділі Filter by Object Size встановіть значення для Max. Size и Min. Size. Враховуватися будуть 
тільки ті об'єкти, які потрапляють в заданий діапазон розмірів, всі інші будуть відфільтровані. 
Максимальна ширина або висота мають бути більшими за мінімальну ширину або висоту. 

6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

7. Для скидання результатів підрахунку натисніть Clear Counting Result. 

8. Натисніть кнопку Save для збереження. 

Автоматичне стеження 

Камера автоматично відстежує об'єкт, який відповідає правилу. 

 

ПРИМІТКА! 
 Не всі моделі камер підтримують цю функцію. 
 Підтримувані функції спрацювання сигналізації і розкладу постановки на охорону залежать 

від конкретної моделі камери. Для отримання детальної інформації див. фактичний веб-
інтерфейс. 

 

1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Auto Tracking і натисніть . 
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2. Встановіть тайм-аут відстеження (у секундах) і коефіцієнт зуму. 

3. Натисніть кнопку Save для збереження. 

Теплова карта 

На тепловій карті використовуються різні кольори для відображення схем руху відвідувачів. Темний 
колір, наприклад червоний, означає більшу щільність руху. 

1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Heat Map і натисніть . 

 
2. Встановіть галочку в поле Enable. 

3. Задайте Background Update Rate. Чим вище значення, тим швидше оновлюється зображення. 

4. Задайте Sensitivity. Чим вище значення, тим більша ймовірність виявлення малих об'єктів. 

5. Задайте Min. Object Size. Чим вище значення, тим більше малих об'єктів не буде виявлено. 

6. Задайте інтервал оновлення статистичного звіту на платформі. 
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7. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

8. Натисніть кнопку Save для збереження. 

Виявлення розфокусування 

 

ПРИМІТКА! 
 Не всі моделі камер підтримують цю функцію. 
 Підтримувані функції спрацювання сигналізації і розкладу постановки на охорону залежать 

від конкретної моделі камери. Для отримання детальної інформації див. фактичний веб-
інтерфейс. 

 

Використовуйте функцію виявлення розфокусування щоб отримувати попередження при виявленні 
розфркусування камери. 

1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Defocus і натисніть . 

 

2. Виберіть Defocus Detection. 

3. Налаштуйте чутливість виявлення та дії по сигналу тривоги відповідно до ваших вимог. Щоб 
дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

4. Натисніть кнопку Save для збереження. 

Виявлення зміни сцени 

 

ПРИМІТКА! 
 Не всі моделі камер підтримують цю функцію. 
 Підтримувані функції спрацювання сигналізації і розкладу постановки на охорону залежать 

від конкретної моделі камери. Для отримання детальної інформації див. фактичний веб-
інтерфейс. 

 

Використовуйте функцію виявлення зміни сцени, щоб розпізнавати зміни в області контролю, 
спричинені зовнішніми факторами, наприклад навмисним обертанням камери, і отримувати 
сповіщення про такі події. 

1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Scene Change і натисніть . 
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2. Виберіть Scene Change Detection. 

3. Задайте чутливість виявлення. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону 
відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в 
Налаштування параметрів сигналізації детекції руху. 

4. Натисніть кнопку Save для збереження. 

Додаткові налаштування 

Додаткові налаштування включають опції чіткості знімків і режими виявлення для інтелектуальних 
функцій. 

Параметри фото 

Налаштуйте чіткість знімків. 

1. Натисніть Setup > Intelligent > Advanced Settings. Відкрийте вкладку Photo parameters. 

 

2. Налаштуйте чіткість мініатюри зображення. 

3. Натисніть кнопку Save для збереження. 

 

ПРИМІТКА! 
Перед налаштуванням параметрів фото відключіть функцію розпізнавання облич. 
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Параметри виявлення 

 

ПРИМІТКА! 
 Не всі моделі камер підтримують додаткові налаштування. Для отримання детальної 

інформації див. фактичний веб-інтерфейс. 
 Режим виявлення за замовчуванням: Normal Mode. Налаштуйте відповідно до ваших вимог. 

 

1. Натисніть Setup > Intelligent > Advanced Settings. Відкрийте вкладку Detection parameters. 

 

 

2. Виберіть режим виявлення. Виберіть Filter Repeated Motion Mode щоб запобігти передачі 
повторних сигналів тривоги при повторному виявленні руху в зоні контролю. 

3. Натисніть кнопку Save для збереження. 

 

З’єднання корпусної і купольної камери 

 

ПРИМІТКА! 
 Не всі моделі камер підтримують цю функцію. 
 Підтримувані параметри з’єднання, режим з’єднання і графік подачі тривожного сигналу 

можуть відрізнятися залежно від моделі камери. Для отримання детальної інформації див. 
фактичний веб-інтерфейс. 

1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Box-Dome Linkage, натисніть  і виберіть 

вкладку Linkage Parameter. 

 
Для деяких моделей камер сторінка відображається наступним чином. 
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2. Встановіть галочку в поле Enable Box-Dome Linkage. 

3. Задайте головну або підпорядковану IP-адресу, HTTP-порт і коефіцієнт масштабування.  

4. Натисніть кнопку Save для збереження. 

5. Виберіть вкладку Mark Linkage. 

 

6. Натисніть Manual Mark, відобразиться наступна сторінка. Призначення кнопок:  
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Попередній/наступний: змінити розмітку сцени після завершення розмітки на поточній сцені. 

Кінцева мітка: завершення розмітки без збереження. 

Додати/Видалити: додати або видалити точку розмітки. 

Видалити все: видалити усі точки розмітки на цій сторінці. 

7. Етапи нанесення розмітки на одній сторінці: натисніть Add, а потім натисніть на зображенні лівої 
головної камери. При натисканні з'явиться невелика біла рамка і область автоматично 
збільшиться (як показано нижче). Для підтвердження поточної точки розмітки натисніть OK, або 
натисніть праву кнопку миші щоб повернутися до оригінального зображення. 

 

8. Поверніть підпорядковану камеру в положення, де розташована точка розмітки. Встановіть 
максимальне збільшення для підлеглої камери, і намалюйте хрест в центрі зображення цієї 
камери, який збігається з точкою розмітки (маленькою білою рамкою) на зображенні головної 
камери. Натисніть OK і Orient для з’єднання точок розмітки. Натисніть Cancel щоб скасувати 
з’єднання точок розмітки.  
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9. Натисніть на інше місце на зображенні основної камери і повторіть останній крок. Може 
знадобитися 5-12 точок розмітки, в залежності від потреби. Щоб перейти до наступної сцени, 
натисніть Finish і Next. 

10. Коли налаштування розмітки завершено, натисніть Apply. Для мультисенсорних камер натисніть 
кнопку після того як буде виконане налаштування розмітки чотирьох сцен. 

 
 

Налаштування загальних сигналів тривоги  
Ви можете запланувати надсилання звітів про тривоги і встановити дії, які можуть бути запущені 
іншими пристроями, щоб тривожні сигнали та дії у відповідь були опрацьовані вчасно. 

Звіти про тривогу можна запланувати для виявлення руху, тривожного входу і виходу, виявлення злому 
і тривогу по звуку. Підтримувані типи тривог залежать від конкретної моделі камери. Щоб дізнатися, 
які типи тривог підтримує ваша камера, див. веб-інтерфейс. 

Налаштування параметрів сигналізації детекції руху 

Функція детекції руху дозволяє виявити переміщення об'єкта в заданій прямокутній області протягом 
певного проміжку часу. Генерація камерою сигналу тривоги при виявленні руху залежить від наступних 
параметрів: зони виявлення, чутливості виявлення, розміру об'єкта та історії подій. Ці параметри 
повинні бути задані користувачем. 

 

ПРИМІТКА! 
 Ця функція не підтримується деякими моделями. Для отримання детальної інформації див. фактичну 

модель. 
 Дії по сигналу тривоги залежать від конкретної моделі. Для отримання детальної інформації див. 

фактичний веб-інтерфейс. 
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Область виявлення 

1. Натисніть Setup > Events > Common Alarm > Motion Detection. Встановіть для параметра Detection 
Mode значення Area. 

 

2. У розділі Detection Area натисніть  щоб додати нову область виявлення. Для видалення області 

виявлення натисніть . 
3. Задайте область виявлення, використовуючи функцію перетягування миші. 

4. Генерація сигналу тривоги  камерою при виявленні руху також залежить від наступних параметрів: 
чутливості виявлення, розміру об'єкта і історії подій. Ці параметри мають бути встановлені 
користувачем. 

 Переміщення повзунка вправо підвищує чутливість виявлення. Коли розмір рухомого об'єкта в 
зоні виявлення перевищує заданий розмір, камера посилає сигнал тривоги. 

 Розмір об'єкта визначає мінімальне відношення розміру порушника до розміру всієї зони 
виявлення, на якій спрацьовує сигналізація. Таким чином, для виявлення руху малих об'єктів 
необхідно намалювати відповідне мале поле (область виявлення) в фактичній області руху. 

 Результати детекції руху відображаються в режимі реального часу. Червоні лінії представляють 
собою сигнали тривоги, що активуються при виявленні руху. Чим довше лінія, тим більше 
тривалість руху. Чим товщі лінія, тим більше частота руху. 

 
 

5. Налаштування параметрів сигналізації. 

 Ігнорування сигналів тривоги: після першого спрацювання сигналізації ті ж самі сигнали тривоги  
не будуть відправлятися протягом встановленого проміжку часу. 

 Скидання сигналів тривоги: якщо після першого спрацювання сигналізації, 
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a. той же самий сигнал тривоги не буде активований протягом вказаного часу, цей сигнал 
тривоги буде  скинутий. Після скидання знову буде  можлива  відправка сигналу тривоги такого 
типу. 

b. Якщо той же самий сигнал тривоги  буде активований протягом вказаного часу, цей сигнал 
тривоги не  буде скинуто, поки не закінчиться час ігнорування цього сигналу. Після цього той 
же  самий сигнал тривоги  може бути відправлено знову. 

6. Вкажіть дії, які запускаються по сигналу детекції руху, і складіть план. 

 

В наступній таблиці наведено опис основних дій по сигналу тривоги і інструкції щодо складання плану. 

Компонент Опис 

Тривожний вихід 
1 

Встановіть галочку. Це налаштування пов'язує інтерфейс тривожного виходу з 
сигналізацією детекції руху. 

Примітка.  
У разі спрацювання сигналізації камера відправляє сигнал на тривожний вихід, щоб 
активувати дії за допомогою пристроїв сторонніх виробників. 

Перехід до 
пресету 

Встановіть галочку і задайте пресет, пов'язаний з сигналізацією детекції руху. 

Примітка.  
 Переконайтеся, що пресети задані. Інакше ви не зможете налаштувати цей параметр. 

Для отримання додаткової інформації про налаштування пресетів див. Налаштування 
пресетів. 

 При спрацьовуванні сигналізації PTZ-камера автоматично використовує пресет для 
запису відео у відповідній сцені. 

Завантажити на 
FTP 

При виборі опції Upload to FTP камера буде автоматично завантажувати знімки на 
вказаний сервер FTP у разі спрацьовування сигналізації. 

Примітка.  
Перед використанням цієї функції переконайтесь, що налаштування параметрів FTP і 
Створення знімків. виконані. 

Запис 

При виборі функції Recording камера буде автоматично записувати відео у разі 
спрацьовування сигналізації. 

Примітка.  
Спочатку налаштуйте параметр Post-Record(s) на сторінці Storage. Параметр Post-
Record(s) визначає тривалість запису після закінчення тривоги. 
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Повідомити 
центр 

При виборі функції Alarm the Center камера буде надсилати інформацію про сигнали 
тривоги на центральний сервер в разі спрацювання сигналізації. 

Примітка.  

Спочатку завершіть налаштування на сторінці Server. 

Відстеження по 
спрацюванню 

При виборі функції Trigger Tracking камера буде автоматично запускати стеження за 
об’єктом в разі спрацювання сигналізації. 

Примітка.  

Не всі моделі камер підтримують цю функцію. 

Спочатку активуйте функцію автоматичного стеження на сторінці Smart Settings. 

Повідомлення 
про 
спрацювання 
по ел. пошті.  

При виборі функції Trigger E-mail камера буде автоматично надсилати знімки на вказану 
адресу електронної пошти в разі спрацювання сигналізації. 

Примітка.  
Перед використанням цієї функції переконайтеся, що налаштування параметра 
Електронна пошта виконане. 

Скласти план 

Встановіть галочку і задайте час початку і закінчення детекції руху. Ви можете скласти 
план, використовуючи функцію перетягування миші, і натиснути Edit для зміни періодів 
часу в таблиці. Періоди часу не повинні перекриватися. Камера посилає сигнали  тривоги 
лише в задані проміжки часу. 

Ви можете вибрати дні з понеділка по неділю і встановити чотири періоди в межах 
кожного дня. 

 

 

Складання плану за допомогою функції 
перетягування миші 

Зміна періодів часу в таблиці 

Примітка.  
Складання плану з допомогою миші підтримується тільки для Internet Explorer версії не 
нижче 8.0. Склавши план на один день, ви можете застосувати ті ж параметри і для інших 
днів за допомогою операцій Copy і Paste. 

 

7. Натисніть кнопку Save для збереження. 

Детекція по сітці 

1. Натисніть Setup > Events > Motion Detection. Встановіть для параметра Detection Mode значення 
Grid. 
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2. Області виявлення на сітці можуть мати неправильну форму. 

3. Задайте чутливість, при якій камера надсилатиме сигнал тривоги, виявивши рух (сигнали тривоги 
можна переглядати на сумісному відереєстраторі). 

4. Налаштування параметрів сигналізації. 

 Ігнорування сигналів тривоги: після першого спрацювання сигналізації ті ж самі тривожні сигнали  
не будуть відправлятися протягом вказаного часу. 

 Скидання сигналів тривоги: якщо після першого спрацювання сигналізації, 

a. той же самий сигнал тривоги не буде активований протягом вказаного часу, цей сигнал 
тривоги буде  скинутий. Після скидання знову буде  можлива  відправка сигналу тривоги такого 
типу. 

b. Якщо той же самий сигнал тривоги  буде активований протягом вказаного часу, цей сигнал 
тривоги не  буде скинуто, поки не закінчиться час ігнорування цього сигналу. Після цього той 
же  самий сигнал тривоги  може бути відправлено знову. 

5. Вкажіть дії, які запускаються по сигналу детекції руху, і складіть план. Для отримання детальної 
інформації див. опис дій по сигналу тривоги у підрозділі Область виявлення розділу Налаштування 
параметрів сигналізації детекції руху. 

6. Натисніть кнопку Save для збереження. 

Налаштування параметрів сигналізації при сторонньому втручанні 

Налаштуйте параметри сигналізації при сторонньому втручанні, щоб камера посилала сигнал тривоги, 
коли об'єктив заблокований протягом певного проміжку часу. 

 

ПРИМІТКА! 
 Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 

фактичну модель. 
 Дії по сигналу тривоги залежать від конкретної моделі. Для отримання детальної інформації див. 

фактичний веб-интерфейс. 
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1. Натисніть Setup > Events > Common Alarm >Tampering Alarm. 

 

2. Виберіть для параметра Tampering Alarm значення On. 

3. Налаштуйте чутливість і період часу, протягом якого камера має сигналізувати про 
несанкціоноване втручання. 

Чутливість має три рівні: високий, середній і низький. Порівняно з чутливістю середнього рівня, 
камера може виявити блокування з більш далекої відстані, якщо встановлено високий рівень 
чутливості. Камера посилає сигнал тривоги, коли об'єктив заблокований протягом певного 
проміжку часу. 

Сигнал тривоги про стороннє втручання діє на весь екран. Для відключення сигналізації про 
стороннє втручання зніміть відмітку Tampering Alarm. 

4. Налаштуйте дії по сигналу тривоги про стороннє втручання і складіть план. Щоб дізнатися більше, 
див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху. 

5. Натисніть кнопку Save для збереження. 

Налаштування параметрів сигналізації по звуку 

Камера може аналізувати вхідні звукові сигнали для виявлення винятків. Коли гучність зростає або 
падає відносно заданої межі, або досягає певного порогу, камера посилає сигнал  тривоги і запускає 
задані дії. Переконайтесь, що пристрій аудіовходу належним чином підключено до камери, а 
аудіовхід включений у розділі Налаштування параметрів тривожного входу. 

 

ПРИМІТКА! 
 Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 

фактичний веб-інтерфейс. 
 Дії по сигналу тривого залежать від конкретної моделі. Для отримання детальної інформації див. 

фактичний веб-інтерфейс. 
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1. Натисніть Setup > Events > Common Alarm >Audio Detection. 

 
2. Виберіть для параметра Audio Detection значення Enable. Виберіть тип виявлення і встановіть 

межі відмінності або поріг. Щоб відключити тривогу по звуку, зніміть галочку Enable. 

У таблиці нижче описано деякі основні параметри. 

Параметр Опис 

Тип виявлення 

 Раптове підвищення: сигнал  тривоги надсилається, коли гучність перевищує межу 
відмінності. 

 Раптове зниження: сигнал  тривоги надсилається, коли гучність падає нижче межі 
відмінності. 

 Раптова зміна: сигнал тривоги надсилається, коли гучність підвищується або 
знижується відносно заданної межі відмінності. 

 Поріг: сигнал тривоги надсилається, коли гучність перевищує порогове значення. 

Різниця 

 Поріг: після установки порогу гучності сигнал тривоги надсилається, коли гучність 
перевищує поріг. 

 Різниця: різниця між двома рівнями гучності. Сигнал  тривоги надсилається, коли 
гучність зростає або знижується щодо заданої межі відмінності. 

Примітка.  
 Для вимірювання гучності звуку використовується шкала в  області тривоги по звуку . 
 Результати тривоги по звуку  відображаються в режимі реального часу. В червоній зоні 

показані відправлені сигнали тривоги по звуку. 

 

ScaleVolume
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Параметр Опис 

 

 

3. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. 
Щоб дізнатися більше, див. опис дій по сигналу тривоги в Налаштування параметрів сигналізації 
детекції руху. 

4. Натисніть кнопку Save для збереження. 

Налаштування параметрів тривожного входу 

Камера може отримувати сигнали тривоги  від пристроїв сторонніх виробників. Щоб скористатися цією 
функцією, спочатку необхідно налаштувати наступні параметри для тривожного входу: порт, назва 
сигналу тривоги, тип сигналу тривоги (нормально закритий [N.C.] або нормально відкритий [N.O.]) і час 
відправки сигналу тривоги. 

 

ПРИМІТКА!  
 Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 

фактичну модель. 
 Дії по сигналу тривоги залежать від конкретної моделі. Для отримання детальної інформації див. 

фактичний веб-інтерфейс. 

 

Difference
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1. Натисніть Setup > Events > Common Alarm > Alarm Input. 

 

2. Виберіть сигнал тривоги і дайте йому назву. 

3. Виберіть N.O. або N.C. відповідно до типу тривожного виходу пристрою стороннього виробника. 
Наприклад, якщо тривожний вихід пристрою стороннього виробника в звичайному стані 
відкритий, слід вибрати N.O., щоб камера могла отримувати сигнали  тривоги з виходу цього 
пристрою. 

4. Налаштуйте дії по сигналу тривоги з тривожного входу і складіть план. Щоб дізнатися більше, див. 
описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху. 

5. Натисніть кнопку Save для збереження. 

Налаштування параметрів тривожного виходу 

Після активації тривожного виходу при виявленні руху (булевский сигнал) камера може передати 
тривожну інформацію на пристрій стороннього виробника, якщо тривожгний вихід коректно 
налаштований як нормально закритий (N.C.) або нормально відкритий (N.O.). Тривалість роботи 
тривожного виходу може бути змінена. 

 

ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 
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1. Натисніть Setup > Events > Common Alarm > Alarm Output.  

 
2. Виберіть сигнал тривоги і дайте йому назву. 

3. Встановіть статус N.O. (налаштування за замовчуванням) і встановіть тривалість сигналу тривоги. 

4. Встановіть режим ретрансляції для кращої адаптації до сторонніх тривожних пристроїв, 
наприклад сигнальних ламп. Виберіть режим очікування відповідно до сторонного тривожного 
пристрою. 

Компонент Опис 

Моностабільний Тривожний вихід запускає сторонній тривожний пристрій за допомогою імпульсу. 

Бістабільний Тривожний вихід запускає сторонній тривожний пристрій за допомогою високого або 
низького рівня. 

 

5. Налаштуйте дії по сигналу тривоги з тривожного виходу і складіть план. Щоб дізнатися більше, див. 
опис дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху. 

6. Натисніть кнопку Save для збереження. 

 

ЗАСТЕРЕЖЕННЯ! 
Суворо дотримуйтесь процедури увімкнення живлення пристроїв, щоб уникнути пошкодження 
компонентів камери.  
1. Переконайтеся, що для типу сигналу  тривоги вибрано значення Normally Open (налаштування 

за замовчуванням), а камера і пристрій тривожного виходу вимкнуті.  
2. Після того, як підключення виконано, увімкніть спочатку камеру, а потім пристрій тривожного 

виходу. 
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Збереження даних на карту пам'яті 

 ПРИМІТКА! 
 Ця функція не підтримується деякими моделями і може працювати по-різному залежно від 

моделі. Для отримання детальної інформації див. фактичну модель. 
 Коли камера працює в автономному режимі, рекомендується використовувати локальну 

пам'ять. Коли камерою керує центральний сервер, необхідно припинити використання 
локальної пам'яті, щоб запобігти збою служби подальшого запису в кеш. 

 Запис після події відображається, якщо камера оснащена такою функцією. Даний параметр 
не відображається, якщо функція не підтримується камерою 

 

Налаштування параметрів локальної пам'яті 

Локальна пам'ять використовується для збереження відео і зображень безпосередньо на карту пам'яті. 
Коли камера працює в автономному режимі, рекомендується використовувати локальну пам'ять. 

Збереження даних вручну 

Якщо ввімкнено режим збереження даних вручну, камера буде періодично записувати відео 
реальному часі. 

1. Натисніть Setup > Storage > Storage. 

 
2. Активуйте локальну пам'ять і змініть налаштування відповідно до ваших потреб. У таблиці нижче 

описано деякі основні параметри. 

Параметр Опис 

Носій 
інформації 

Тип ресурсу зберігання. 

Примітка.  
 Щоб відформатувати карту пам'яті, спочатку відключіть функцію збереження даних на 

карті. Потім натисніть Format і OK для підтвердження. Після завершення 
форматування система перезавантажиться. 

 Відображається інформація про загальну і вільну ємність. 
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Політика 
видалення 
даних 

 Перезапис: якщо на карті пам'яті не залишиться вільного місця, нові дані будуть 
записуватися за рахунок періодичного видалення наявних даних. 

 Зупинка: якщо на карті пам'яті не залишиться вільного місця, нові дані не будуть 
зберігатися на цій карті. 

Записи після 
події 

Цей параметр визначає тривалість запису після закінчення тривоги в режимі запису по  
сигналу тривоги. 

 

3. Натисніть кнопку Save для збереження. 

Розклад запису 

Якщо розклад запису активовано, камера записує відео на карту пам'яті протягом вказаних проміжків 
часу. 

1. Натисніть Setup > Storage > Storage. 

 

Для деяких моделей камер сторінка відображається наступним чином. 
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2. Виберіть Planned Storage, а потім встановіть періоди, протягом яких камера повинна записувати 
відео на карту пам'яті. 

3. Натисніть кнопку Save для збереження. 

 ПРИМІТКА!  
 Розклад запису не працює, коли увімкнено режим збереження даних вручну. 
 Для перегляду записів з карти пам'яті, див. Відтворення відео і його завантаження в локальну 

пам'ять. 

 

Налаштування подальшого запису в кеш 

При централізованому керуванні камера може використовувати карту пам'яті  як ресурс резервного 
копіювання даних для центрального сервера керування. Якщо процес збереження даних з камери в 
центральне сховище переривається через нестабільне мережеве з'єднання, камера автоматично 
переключиться в режим подальшого запису в кеш і почне зберігати відео на карту пам'яті. 

Якщо увімкнуто режим резервного копіювання запису, камера може автоматично передавати 
відеозаписи, збережені на карті пам'яті у вигляді файлу, в сховище сервера резервного копіювання, 
коли зв'язок між камерою і цим сервером відновиться. 

 ПРИМІТКА! 
Перед налаштуванням режиму подальшого запису в кеш для камери перевірте наступне.  

 Карта пам'яті належним чином встановлена в камеру. 
 Ресурс резервного копіювания доданий на центральному сервері. 
 Ресурс резервного копіювания був виділений для камери. 
 Запис після події відображається, якщо камера оснащена такою функцією. Даний параметр 

не відображається, якщо функція не підтримується камерою 
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Відключення локальної пам'яті 

1. Натисніть Setup > Storage > Storage. 

 
2. В полі Storage Policy виберіть Off. Запис після події відображається, якщо камера оснащено цією 

функцією. У такому випадку задайте Post-Record(s). 

3. Натисніть кнопку Save для збереження. 

Обслуговування системи 

 ПРИМІТКА!  
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 

Безпека 

Керування користувачами 

Існує два типи користувачів у даній системі.  

 Адміністратор (admin). Ім'я адміністратора за замовчуванням: admin. Це ім'я змінити не можна. 
Адміністратор має всі повноваження та може керувати всіма користувачами і пристроями. У цій 
системі може бути тільки один адміністратор. 

 Звичайний користувач, названий у цьому посібнику як «користувач». Користувач має право лише 
переглядати живе відео і відеозаписи. В цій системі може бути до 32 звичайних користувачів. 

Ви можете додати користувача в інтерфейсі керування користувачами (вибравши Setup > Security > 
User). 

Після додавання користувача ви можете змінити пароль шляхом вводу нового пароля, або видалити 
користувача, видаливши його ім'я. 

 ПРИМІТКА! 
 Лише адміністратор може змінювати паролі. Зміна імені або пароля користувача, який 

знаходиться в системі, призведе до примусового виходу цього користувача з системи. Для 
наступного входу в систему необхідно буде використати нове ім'я користувача чи новий 
пароль. 

 Лише адміністратор може додавати або видаляти користувачів. Видалення користувача, який 
знаходиться в системі, призведе до примусового виходу цього користувача з системи. 
Видалений користувач не зможе увійти до системи. 
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Налаштування безпечної передачі даних 

Налаштуйте захищений канал передачі даних для безпеки. 

 ПРИМІТКА!  
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 

1. Натисніть Setup > Network > Port. 

 
2. Введіть номер порту в текстове поле HTTPS Port. 

3. Натисніть кнопку Save для збереження. 

4. Натисніть Setup > Security > Network Security > HTTPS. 

 

5. Виберіть для HTTPS значення On. При необхідності ви можете імпортувати сертифікат користувача 
SSL. 

6. Натисніть кнопку Save для збереження. 

При наступному вході в систему введіть адресу в форматі https: //IP: HTTPS port number, наприклад 
https: //192.168.1.13: 443, щоб увійти в режимі захищеного каналу зв’язку. Якщо ви використовуєте 
порт HTTPS за замовчуванням, введіть https: //IP. 

Автентифікація  

Протоколом прикладного рівня є RTSP (протокол потокової передачі в реальному часі). Щоб 
передавати аудіо/відеосигнали і керувати ними, встановіть автентифікацію RTSP у веб-інтерфейсі. 

1. Натисніть Setup > Security > Network Security > Authentication. 

 
2. Виберіть режим автентифікації і натисніть Save. 

Приховування інформації постачальника 

Ви можете приховати інформацію постачальника мережевої камери в веб-інтерфейсі. 
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1. Натисніть Setup > Security > Registration Info. 

 
2. Встановіть для параметра Registration Info значення On. 

3. Натисніть кнопку Save для збереження. 

Захист APR 

Ця функція захищає камеру від атак ARP. Перш ніж ПК зможе отримати доступ до камери з іншої мережі, 
необхідно коректно встановити шлюз і MAC-адресу. Якщо вказано невірну MAC-адресу, ПК зможе 
отримати доступ до камери лише перебуваючи в тій же локальній мережі. 

1. Натисніть Setup > Security > Network Security > ARP Protection. 

 

2. Встановіть мітку, щоб включити функцію прив'язки ARP, і задайте MAC-адресу шлюзу. 

3. Натисніть кнопку Save для збереження. 

Фільтр IP-адрес 

Використовуйте фільтр IP-адрес, щоб дозволити або заборонити доступ із зазначених IP-адрес. 

 ПРИМІТКА!  
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 

1. Натисніть Setup > Security > Network Security > IP Address Filtering. 

 
2. Для активації фільтра IP-адрес виберіть значення On. 

3. Виберіть режим фільтрації, а потім додайте IP-адреси. 

4. Натисніть кнопку Save для збереження. 
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 ПРИМІТКА! 
 Якщо для параметра Filtering Mode вибрано значення Whitelist, тоді камера буде доступна 

лише для доданих IP-адрес. Якщо для параметра Filtering Mode вибрано значення Deny 
Access, тоді камера буде недоступна лише для доданих IP-адрес. 

 Максимальна кількість IP-адрес: 32. Кожна IP-адреса може бути додана тільки один раз. 
 Перший байт кожної IP-адреси повинен бути 1-223, а для четвертого не можна 

використовувати 0. Наприклад, наступні IP-адреси є недопустимі і не можуть бути додані: 
0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1. 

 

Політика доступу 

 ПРИМІТКА! 
Увімкнення функції зручного пароля не впливає на використання системи. Якщо ви відключите її і 
увійдете в систему з ненадійним паролем, з'явиться сторінка з вимогою змінити пароль. На цій 
сторінці не буде кнопки для скасування або закриття. Пароль за замовчуванням вважається 
ненадійним. 

 

1. Натисніть Setup > Security > Network Security > Access Policy. 

 

2. Щоб активувати зручний пароль і автентифікацію MAC, виберіть значення On. 

3. Натисніть кнопку Save для збереження. 

Водяний знак 

Використовуйте водяний знак для захисту користувацької інформації у відеозапису, щоб запобігти її 
несанкціонованому видаленню або зміні. 

 ПРИМІТКА! 
Не всі моделі камер підтримують цю функцію. 

 

1. Натисніть Setup > Security > Watermark. 

 

2. Виберіть On, щоб активувати водяний знак, а потім введіть його вміст. 

3. Натисніть кнопку Save для збереження. 

Встановлення системного часу 

Ви можете скористатися наступними методами для коригування системного часу пристрою. 

Встановлення або синхронізація системного часу вручну 

1. Натисніть Setup > Common > Time, а потім відкрийте вкладку Time. 
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2. Виберіть метод синхронізації. 

3. Встановіть свій часовий пояс і системний час. Ви можете також натиснути Sync with Computer Time 
для синхронізації часу камери з часом ПК. 

4. Натисніть кнопку Save для збереження. 

Синхронізація з сервером NTP 

1. Натисніть Setup > Common > Time, а потім відкрийте вкладку Time. 

 

2. Встановіть для параметра Sync Mode значення Sync with NTP Server, а потім задайте IP-адресу і 
порт сервера NTP, а також інтервал оновлення. 

3. Натисніть кнопку Save для збереження. Камера буде періодично синхронізувати час з сервером 
NTP. 

Встановлення літнього часу 

1. Натисніть Setup > Common > Time, а потім відкрийте вкладку DST. 

 

2. Виберіть для DST значення On, встановіть часу початку, час завершення і зміщення літнього часу. 

3. Натисніть кнопку Save для збереження. 

Налаштування параметрів серверів 

Інтелектуальний сервер 

Якщо високочутливою камерою керує центральний сервер, ви повинні налаштувати інтелектуальний 
сервер. 

 ПРИМІТКА! 
 Не всі моделі камер підтримують роботу з інтелектуальним сервером. 
 Для використання знімків облич необхідно задати параметри сервера TMS, на який 

завантажуються знімки. 
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1. Натисніть Setup > Common > Time, а потім відкрийте вкладку Intelligent Server. 

 
2. Вкажіть IP-адресу сервера TM і налаштуйте інші параметри. 

3. Натисніть кнопку Save для збереження. 

Налаштування режиму послідовного порту 

Послідовний порт RS485 використовується для обміну даними з  пристроями сторонніх виробників. 
Параметри послідовного порту на камері мають відповідати аналогічним параметрами підключеного 
пристрою стороннього виробника. 

 ПРИМІТКА! 
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 

Керування PTZ 

Для керування PTZ-камерою через пристрій стороннього виробника необхідно встановити для 
параметра Port Mode значення PTZ Control.  

Щляхом відправки команд PELCO-D, сумісних з керуванням PTZ (панорамування-нахил-зум), через 
порт RS485 ви можете керувати PTZ-камерою, не використовуючи пульт керування PTZ. 

1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port. 

 

2. Виберіть опцію PTZ Control у випадаючому списку Port Mode. У таблиці нижче описано деякі 
основні параметри. 

Параметр Опис 

Протокол PTZ Встановіть протокол PTZ, який підтримує канал. 

Server IP

Server Port

Device No.
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Параметр Опис 
Примітка.  
 Ви можете налаштувати цей параметр тільки тоді, коли для параметра Port Mode 

встановлено значення PTZ Control.  
 Коли для параметра PTZ Protocol задано значення INTERNAL-PTZ, камера може 

підключитися до зовнішнього контролера PTZ без використання послідовного порту 
(параметри послідовного порту відображаються сірим кольором). В цьому випадку 
вам потрібно лише підключити інтерфейси зуму і фокусування камери до об'єктива, 
після чого ви зможете керувати PTZ як внутрішнім PTZ-пристроєм. 

Режим PTZ 

 Пріоритет вбудованої системи PTZ: при виборі цієї опції камера спочатку намагається 
керувати PTZ (панорамування-нахил-зум) автономно замість того, щоб 
використовувати зовнішній контролер PTZ. Для операцій, які камера не може 
виконувати автономно, використовуватиметься зовнішній контролер PTZ. 

 Пріоритет зовнішньої системи PTZ: камера спочатку буде керувати PTZ через 
контролер PTZ, підключений до послідовного порту. 

Примітка.  
 Ви можете налаштувати цей параметр тільки тоді, коли для параметра Port Mode 

встановлено значення PTZ Control. 
 При виборі INTERNAL-PTZ для цього параметра завжди встановлюється значення 

Built-in PTZ Priority, тому немає сенсу підключати камеру до зовнішнього контролера 
PTZ через послідовний порт. Якщо ви все ж підключите камеру до зовнішнього 
контролера PTZ, він не зможе керувати камерою. 

 Виберіть значення цього параметра відповідно до ваших потреб. Переконайтеся, що 
відповідні інтерфейси керування PTZ  підключені належним чином. 

Код адреси 

Задайте код адреси для PTZ. 

Примітка.  
Ви можете налаштувати цей параметр тільки тоді, коли для параметра Port Mode 
встановлено значення PTZ Control, а для параметра PTZ Protocol не встановлено 
значення INTERNAL-PTZ. 

 

3. Натисніть кнопку Save для збереження. 

Прозорий канал 

Для обміну даними з пристроями сторонніх виробників по прозорому каналу використовується 
послідовний порт RS485. Прозорий канал використовується переважно для відкритої передачі данних 
між двома пристроями. 

 ПРИМІТКА!  
 Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 

фактичну модель. 
 Переконайтесь, що для параметра Port Mode на вашій камері встановлено значення Trans-

Channel. 
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1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port. 

 
2. Виберіть опцію Trans-Channel у випадаючому списку Port Mode. 

3. Виберіть для параметра Trans-Channel значення Enable. 

4. Введіть цільову IP-адресу і номер порту (IP-адресу і номер порту, до якого підключається прозорий 
канал). 

5. Натисніть кнопку Save для збереження. 

OSD 

Для відображення на екрані інформації пристрою стороннього виробника необхідно вибирати 
екранний інтерфейс (OSD) як режим порту. 

Камера отримує інформацію від пристрою стороннього виробника через послідовний порт RS485, 
транслює отриману інформацію, а потім відображає її в екранному інтерфейсі. 

 ПРИМІТКА! 
Щоб камера коректно транслювала інформацію, отриману від пристрою стороннього виробника, 
перконайтесь, що інформація, відправлена цим пристроєм через послідовний порт, відповідає 
формату даних нашої компанії. Для отримання додаткової інформації зверніться до свого дилера. 

 

1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port. 
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2. Виберіть опцію OSD у випадаючому списку Port Mode. Виберіть Enable OSD Report (щоб дані 
екранного інтерфейсу завантажувались на платформу). 

3. Натисніть кнопку Save для збереження. 

Прозорий канал ONVIF 

Ви можете організувати обмін даними через прозорий канал (ONVIF) між портом RS485 камери і 
пристроєм стороннього виробника. 

1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port. 

 

2. Встановіть для параметра Port Mode значення Select Trans-Channel via ONVIF. 

3. Натисніть кнопку Save для збереження. 

Керування склоочисником 

Перед керуванням склоочисником потрібно налаштувати його параметри. 

 ПРИМІТКА!  
Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 

1. Натисніть Setup > System > Ports и Devices і відкрийте вкладку External Device. 

 

2. Задайте режим керування склоочисником. У таблиці нижче описано деякі основні параметри. 

Параметр Опис 

Послідовний порт Склоочисник управляється командами PELCO-D, тому для протоколу PTZ необхідно 
вибрати опцію PELCO-D. Для отримання детальної інформації див. Керування PTZ. 

Тривожний вхід/вихід Використовуйте тривожний вхід/вихід, щоб замкнути або розімкнути ланцюг 
керування склоочисником. 
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Перегляд стану пристрою 

Ви можете переглянути поточний стан своєї камери. 

1. Натисніть Setup > Common > Basic Info. 

 
2. Натисніть Refresh для отримання останньої інформації про стан. 

3. Перегляньте інформацію про пристрій. 

 ПРИМІТКА!  
Можна подивитися модель пристрою, версію вбудованого програмного забезпечення, стан 
розумного сервера і т. д. на сторінці основної інформації. 

 

Стан збереження фотографій 

Ви можете переглянути поточний стан збереження фотографій. Для ознайомлення з повною політикою 
збереження даних див. Збереження даних на карту пам'яті. 

 ПРИМІТКА!  
Тільки моделі з функцією збереження даних підтримують цю функцію. Для отримання детальної 
інформації див. фактичну модель. 

 

IPC

IPC

A

V1.0

2102335CC3531740100232

192.168.1.13/255.255.255.0/192.168.1.1

48:ea:63:4d:56:88

2018/1/25 19:16:27

0 Day(s) 0 Hour(s) 0 Minute(s)

Offline



75 

1. Натисніть Photo. 

 

2. Натисніть Refresh для оновлення стану зберігання даних. 

3. Ви можете експортувати або видаляти фотографії у розділі Image List. 

Оновлення ПЗ пристрою 

Якщо пристроєм керує центральний сервер, і ви хочете оновити ПЗ пристроїв у пакетному режимі, 
рекомендується виконати операцію оновлення на центральному сервері. Для отримання детальних 
інструкцій див. посібник користувача для центрального сервера управління. 

1. Натисніть Setup > System > Maintenance. 

 

2. У розділі Software Upgrade натисніть Browse і виберіть файл оновлення. 

3. Натисніть Upgrade, а потім підтвердіть цю операцію для її запуску. Після завершення оновлення 
система перезавантажиться. Деякі пристрої підтримують оновлення програми завантаження. Для 
оновлення виберіть опцію Upgrade Boot Program. 

4. Ви можете натиснути Detect для пошуку нових версій, доступних через хмарне оновлення. 
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 ПРИМІТКА! 
 Ви повинні викороистовувати файл оновлення, призначений спеціально для вашої камери. 

Інакше можуть виникнути непередбачувані помилки. 
 Оновлення надається в zip-архіві, який повинен містити всі необхідні файли. 
 Програма завантаження завантажує операційну систему, після чого система запускається. 

Функція оновлення програми завантаження за замовчуванням вимкнена, тому лише камера 
буде оновлена до останньої версії. Можна увімкнути режим, при якому оновлюється і камера, 
і програми завантаження, при цьому може бути завантажена операційна система наступної 
нової версії і останнє ПЗ для камери. 

 Забезпечити безперебійне електроживлення під час оновлення. Після завершення оновлення 
система перезавантажиться. 

 

Перезапуск системи 

1. Натисніть Setup > System > Maintenance. 

 
2. У розділі Device Restart натисніть Restart. Пристрій перезавантажиться після підтвердження цієї 

операції.  

 
ЗАСТЕРЕЖЕННЯ! 
Будьте обережні під час виконання цієї операції, оскільки перезавантаження системи призведе до 
переривання поточної роботи. 

 

Імпорт і експорт файлу конфігурації системи 

Ви можете експортувати файл поточної конфігурації камери і зберегти його на ПК або зовнішньому 
накопичувачі. Ви можете також швидко відновити конфігурацію шляхом імпорту в камеру резервних 
копій, збережених на ПК або зовнішньому накопичувачі. 

 
ЗАСТЕРЕЖЕННЯ!  

 Після виконання операції скидання до налаштувань за замовчуванням (Default), заводські 
значення будуть встановлені для всіх параметрів, крім наступних: пароль і логін системного 
адміністратора, налаштування мережі і системний час. 

 Переконайтесь, що ви імпортуєте коректний файл конфігурації для своєї камери. Інакше 
можуть виникнути непередбачувані помилки. 

 Після успішного імпортування файлу конфігурації, камера перезавантажиться. 

 

1. Натисніть Setup > System > Maintenance. 

 

2. Для імпорту збережених файлів конфігурації натисніть Browse поруч з кнопкою Import, виберіть 
файл, який потрібно імпортувати, і натисніть Import. Результат буде показаний на екрані. 
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3. Для експорту поточної конфігурації системи натисніть Browse (поруч з полем Exporting), задайте 
місце призначення і натисніть Export. 

4. Для відновлення конфігурації за замовчуванням натисніть Default і підтвердіть цю операцію. 
Пристрій перезавантажиться і відновить конфігурацію за замовчуванням. При натисканні кнопки 
Default при встановленій галочці пристрій буде відновлено до заводських налаштувань за 
замовчуванням. 

Збір діагностичної інформації 

Діагностична інформація включається в журнали і конфігурацію системи. Ви можете експортувати 
діагностичну інформацію на ПК. 

1. Натисніть Setup > System > Maintenance. 

 

2. В полі Diagnosis Info натисніть Browse, щоб вказати місце призначення, а потім натисніть Export. 

 ПРИМІТКА! 
 Діагностична інформація експортується до локальної папки у вигляді стиснутого файлу. Ви 

повинні розпакувати файл за допомогою архіватора, такого як WinRAR, а потім відкрити файл 
за допомогою текстового редактора. 

 Вибравши опцію Collect Image Debugging Info, ви можете в процесі роботи переглянути відео 
з інформацією щодо налагодження, що полегшує пошук несправностей. 

Параметри фокусування 

Пристрій може регулювати швидкість автофокусування в залежності від мінімальної дистанції 
фокусування. Для чіткої зйомки рекомендується, щоб мінімальна дистанція фокусування була меншою, 
ніж відстань між об'єктами і об'єктивом, наприклад, якщо мінімальна дистанція фокусування 
становить 3 м, тоді об'єкти що знаходяться ближче 3 м від об'єктива будуть не в фокусі. 

 ПРИМІТКА! 
Ця функція підтримується лише пристроями з автофокусуванням. Для отримання детальної 
інформації див. фактичну модель. 

1. Натисніть Setup > System > Maintenance. 

 

2. У розділі Focus задайте значення для параметрів Min. Focus Distance (у см) і Max. Zoom Ratio. 

3. Натисніть OK. 
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Висота встановлення пристрою 

Введіть фактичну висоту купола до землі, щоб камера могла автоматично регулювати параметри 
інфрачервоного підсвічування. 

 ПРИМІТКА! 
Дана функція підтримується лише певними моделями камер з інфрачервоним підсвічуванням. Для 
отримання детальної інформації див. фактичну модель. 

1. Натисніть Setup > System > Maintenance. 

 

2. Введіть фактичну висоту купола інфрачервоного підсвічування до землі. 

3. Натисніть OK. 

Параметри камер FishEye 

Для якісного відображення відео необхідно налаштувати параметри об’єктива FishEye у відповідності 
з фактичним способом монтажу. 

 ПРИМІТКА! 
Дана функція підтримується лише в моделях камер FishEye. Для отримання детальної інформації 
див. фактичну модель. 

 

1. Натисніть Live View > Mount. Виберіть спосіб монтажу. Вибраний спосіб монтажу має співпадати 
з фактичним способом монтажу. 

 
Для деяких моделей камер сторінка відображається наступним чином. 
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2. Налаштуйте параметри. У таблиці нижче описано деякі основні параметри. 

Параметр Опис 

 

 

 

 

 

 

 

 

 

 

 

Одинадцять режимів відображення: 

 Оригінальне зображення 
 Панорамний вид 
 Панорама+3PTZ 
 Панорама+4PTZ 
 Панорама+8PTZ 
 Панорама 360°+1 PTZ 
 Панорама 180° 
 Fisheye+3PTZ 
 Fisheye+4PTZ 
 Панорама 360°+6 PTZ 
 Fisheye+8PTZ 
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Параметр Опис 

 

 

 

Три способи монтажу:  

• На стелі 

• На стіні 

• На столі 
Примітка.  
Вибраний спосіб монтажу повинен співпадати з фактичним способом монтажу. 

 

4  Перегляд у реальному часі 

Живий перегляд означає, що у вікні веб-інтерфейсу відображається відео зі звуком, які отримані від 
камери в режимі реального часу. 

Якщо ви входите в систему з установленою опцією Live View, живе відео відображається за 
замовчуванням. Ви можете двічі клацнути на вікні перегляду, щоб увійти в повноекранний формат або 
вийти з нього. 

 

Панель інструментів живого перегляду 

 ПРИМІТКА! 
Підтримувані функції живого перегляду залежать від моделі камери. Щоб дізнатися, які функції 
підтримує ваша камера, див. веб-інтерфейс. 
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Кнопка Опис 

/  Відтворення/зупинка живого відео. 

 

Регулювання гучності виходу для медіаплеєра на ПК. 

 

Регулювання гучності мікрофона на ПК під час аудіозв'язку між ПК і камерою. 

 

Створення знімка поточного зображення на екрані ПК. 

Примітка.  
Шлях для збереження знімків можна вибрати в меню System Configuration. 

/  

Запуск/зупинка локального запису. 

Примітка.  
Шлях для збереження локальних записів можна вибрати в меню System 
Configuration. 

/  Запуск/зупинка аудіозв’язку між ПК і камерою. 

/  
Запуск/зупинка цифрового зуму. Для отримання більш детальної інформації 
див.  розділ Використання цифрового зуму. 

/  
Запуск/зупинка фокусування зони. Для отримання більш детальної 
інформації див.  розділ Використання фокусування зони. 

/  
Запуск/зупинка 3D-позиціонування. Для отримання більш детальної 
інформації див.  розділ  Використання 3D-позиціонування. 

 Показати/приховати панель керування PTZ. 

 

Встановлення співвідношення сторін екрана. Наприклад, для відображення 
високоякісних зображень в оригінальному форматі 16: 9 виберіть опцію Scale, 
для відображення по розміру вікна виберіть опцію Stretch, а для 
відображення у відповідності до розміру оригінального зображення виберіть 
опцію Original. 

 

Скидання рівня втрат пакетів на нуль. 

Примітка.  
Після переміщення курсору миші у вікно живого перегляду ця кнопка 
з'являється на плаваючій панелі інструментів. 

 

Відображення інформації про рівень втрати пакетів і швидкість передачі 
даних у нижній частині вікна. 

Примітка.  

Після переміщення курсору миші у вікно живого перегляду ця кнопка 
з'являється на плаваючій панелі інструментів. 

Натисніть цю кнопку, щоб завжди відображати таку інформацію. Наступного 
разу, коли ви клацнете мишею, інформація буде з'являтися лише тоді, коли 
ви переміщуєте курсор над вікном або в його нижній частині. Якщо курсор 
миші зависає у вікні приблизно на 3 секунди або виходить з вікна, інформація 
зникає. 

 Натисніть цю кнопку для відкриття сторінки налаштування зображення. 

 Відображення в повноекранному форматі. 
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Кнопка Опис 

 

 

 

Вибір підтримуваного камерою потоку для перегляду відео в реальному часі: 
основний, додатковий або третій. 

 

Перегляд певної області зображень 

Цифровий зум, фокусування зони і 3D-позиціонування дозволяють отримати більш детальні дані про 
певну частину зображення. Цифровий зум збільшує зображення з втратою якості, тоді як 3D-
позиціонування збільшує його без будь-яких втрат. 

Використання цифрового зуму 

 ПРИМІТКА! 
Підтримувані функції живого перегляду залежать від моделі камери. Щоб дізнатися, які функції 
підтримує ваша камера, див. веб-інтерфейс. 

 

1. На сторінці Live View натисніть значок  на панелі інструментів. 

 
2. Натиснувши і утримуючи кнопку миші, перемістіть курсор зверху вниз (намалюйте прямокутник), 

щоб встановити область. Щоб відновити розмір оригінального зображення і збільшити масштаб 
інших його областей,  клацніть правою кнопкою миші. 

3. Щоб вийти, натисніть значок . 
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Використання фокусування зони 

 ПРИМІТКА! 
Підтримувані функції живого перегляду залежать від моделі камери. Щоб дізнатися, які функції 
підтримує ваша камера, див. веб-інтерфейс. 

 

1. На сторінці Live View натисніть значок  на панелі інструментів. 

 
2. Натиснувши і утримуючи кнопку миші, перемістіть курсор зверху вниз (намалюйте прямокутник), 

щоб встановити область. 

3. Щоб вийти, натисніть значок . 

Використання 3D-позиціонування 

 ПРИМІТКА! 
Ця функція доступна лише для мережевих PTZ-камер і корпусних IP-камер, оснащених 
моторизованим об'єктивом і системою PTZ (панорамування-нахил-зум). Для отримання детальної 
інформації див. фактичну модель. 
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1. На сторінці Live View натисніть значок  на панелі інструментів. 

 
2. Натиснувши і утримуючи кнопку миші, перемістіть курсор зверху вниз (намалюйте прямокутник), 

щоб встановити область. Перетягування у зворотньому напрямі (знизу вгору) зменшує масштаб. 

3. Щоб вийти, натисніть значок . 

Живий перегляд з камер FishEye 

 

ПРИМІТКА! 
 Дана функція підтримується лише камерами FishEye. Для отримання детальної інформації 

див. фактичну модель. 
  Зображення попереднього перегляду в мережі може змінюватися залежно від налаштувань 

камер FishEye. Перед запуском живого перегляду налаштуйте параметри FishEye (див. 
Параметри камер Fisheye) і виберіть режим FishEye для камери.  

Є три основні режими відображення: оригінальне зображення, Fisheye і PTZ, панорама і PTZ. При 
різних способах монтажу зображення відображається по-іншому. Нижче наведено приклад настінного 
кріплення. 

Якщо вибрано режим оригінального зображення, зображення FishEye відображаються, як показано 
нижче. 
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Якщо вибрано режим панорами, розгорнуті зображення відображаються, як показано нижче. 
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ПРИМІТКА! 
Якщо вибраний монтаж на стелю або настільний, панорамне зображення (два зображення з 
охопленням 180°) представляють собою розгорнуту версію зображення попереднього перегляду 
FishEye (з охопленням 360°). Встановіть камеру під відповідним кутом огляду згідно до фактичних 
вимог відеоспостереження. 
Наприклад, якщо камера встановлена на стелі, ціль спостереження відображається у верхній частині 
панорамного зображення, коли кут між кабельним виводом пристрою (логотип) і ціллю 
спостереження у напрямі за годинниковою стрілкою складає 135°. 

 
 

Коли для попереднього перегляду в списку праворуч вибраний режим Panoramic+4PTZ (панорама+4PTZ), 
за замовчуванням відображається 4 локальних зображення: зліва направо і зверху вниз. Ви можете 
керувати PTZ і змінювати зум для кожного локального зображення, як показано на малюнку нижче. 

 

Позиція цілі спостереження 
(наприклад, керування доступом) Зображення в режимі 

попереднього перегляду   
FishEye (360°) 

Зображення в режимі 
панорамного попереднього 

перегляду 

Ціль 

Кабельний 
вивід Нижня 

частина 
пристрою 
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Функція 5ePTZ панорамних камер 

 ПРИМІТКА! 
Дана функція передбачена лише для певних моделей камер. Для отримання детальної інформації 
див. фактичну модель. Автоматичне встеження може підтримуватися лише в основному потоці. 

 

1. На сторінці Live View натисніть значок  на панелі інструментів, як показано нижче. 

 

2. При натисканні на значок  в режимі панорами живий прегляд переключиться в режим 
стеження 5ePTZ. Потім камера буде визначати рухомі об'єкти в режимі живого перегляду, коли 
увімкнено функцію захисту периметру. Крім того, вона може відстежувати і збільшувати 5 цілей, 
що запускає правило тривожного сигналу, яке ви налаштовуєте у функції охорони периметра 
практично одночасно. Дана функція працює як функція стеження і масштабування камери PTZ. 



88 

 

3. Для переходу в режим панорами натисніть кнопку  в режимі стеження 5ePTZ. 

 

5  Відтворення відео і його завантаження в 
локальну пам'ять 

 ПРИМІТКА! 
 Под локальною пам'яттю мається на увазі запис відео на карту пам’яті інтерфейсного 

пристрою (головним чином камери). Під локальним записом мається на увазі запис відео за 
допомогою клієнта локального ПК. 

 Перед відтворенням відео з локальної пам'яті перевірте, що в камері встановлено карту 
пам'яті, а сховище налаштовано. 

 Дана функція не підтримується деякими моделями. Для отримання детальної інформації див. 
фактичну модель. 

 



89 

Відтворення відео 

1. Натисніть Playback на домашній сторінці. 

 
2. Виберіть дату в календарі. 

3. Натисніть Query. 

4. У розділі Results двічі натисніть період часу, щоб почати відтворення запису. 

Завантаження 
1. Натисніть Playback на домашній сторінці. 

 

2. Пошук відео в заданий період часу. Результати будуть показані в списку. 

3. Виберіть відео і натисніть Download. Відео буде завантажено в локальну папку з карти пам'яті 
(шлях до локальної папки можна змінити в меню Local Settings). 

4. Натисніть Open, щоб відкрити папку, в яку було збережено завантажене відео. 
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6  Керування PTZ 

Ця функція доступна лише для купольних камер PTZ або корпусних камер, встановлений на поворотно-
похилій платформі з електроприводом.  

 ПРИМІТКА! 
 Деякі функції керування об'єктивом застосовні до камер, обладнаних моторизованим 

об'єктивом. 
 Кнопки керування PTZ залежить від конкретної моделі камери. Щоб дізнатися, які кнопки 

керування PTZ підтримується вашою камерою, див. веб-інтерфейс. 

 

Панель інструментів для керування PTZ 

Компонент Опис 

Пресет 
Виберіть пресет і натисніть . PTZ-камера будет використовувати вибраний 
пресет. 

Для додавання пресету натисніть . Для видалення пресету натисніть . 

Патрулювання 

Виберіть маршрут патрулювання, а потім натисніть  для запуску патрулювання.  

 Для зміни маршруту патрулювання натисніть . 

 Для додавання маршруту патрулювання натисніть . 

 Для видалення маршруту патрулювання натисніть . 

 

Встановіть швидкість руху PTZ-камери. 

 

Встановіть напрямок PTZ-камери і відпустіть кнопку керування. 

/  

/  

/  

/  

/  

Вмикання/вимикання ІЧ-підсвічування. 

Вмикання/вимикання склоочисника. 

Вмикання/вимикання нагрівача. 

Вмикання/вимикання освітлення. 

Вмикання/вимикання системи видалення снігу. 

 

Фокусування камери. 

 

Зміна зуму камери. 



91 

Компонент Опис 

 

Збільшення/зменшення діафрагми. 

 

Кнопки швидкого доступу для керування PTZ. Після того як курсор миші прийме 
одну з цих форм на екрані живого перегляду,  натисніть і утримуйте ліву кнопку 
миші для керування PTZ-камерою. 

Примітка.  
 Тільки купольні і звичайні PTZ-камери підтримують цю функцію. 
 Ці кнопки не діють під час використання 3D-позиціонування або цифрового 

зуму. 

 

Кнопки швидкого доступу для зміни масштабу зображення в режимі живого 
перегляду. Поверніть коліщатко вперед, щоб збільшити масштаб, або назад, щоб 
зменшити його. 

Примітка.  
Цю функцію підтримують лише камери з моторизованим об'єктивом. 

 

Налаштування патрулювання за допомогою пресетів 

Налаштування пресетів 

На вкладці Preset ви можете налаштовувати пресети і виконувати певні операції по керуванню PTZ-
камерою. Для отримання додаткової інформації див. розділ Панель інструментів для керування PTZ. 

Додавання пресету 

1. На сторінці Live View натисніть Preset на панелі інструментів. 

 
2. Змініть положення камери, щоб вона мала потрібний напрям огляду. 

3. Налаштуйте зум і фокус для отримання оптимального зображення. 

4. Для додавання цих налаштувань як пресету натисніть . Введіть номер і назву пресету, а потім 
натисніть OK. 

1

2

3

4
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Перехід до пресету 

1. На сторінці Live View натисніть Preset на панелі інструментів. 

 

2. Щоб перейти до пресету, натисніть . PTZ-камера буде використовувати вибраний пресет. 

Видалення пресету. 

1. На сторінці Live View натисніть Preset на панелі інструментів. 

 

2. Натисніть  для пресету, а потім підтвердіть видалення. 

1 2

1 2
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Налаштування патрулювання 

Маршрут патрулювання - це шлях, яким слідує PTZ-камера, рухаючись від одного пресету до іншого. 
Тривалість часу, протягом якого PTZ-камера залишається в кожній позиції пресету, можна змінити. Для 
PTZ-камери можна встановити кілька маршрутів патрулювання. 

Дії патрулювання включають переміщення до заданого пресету, зупинку на деякий час після 
досягнення пресету і рух до наступного пресету. Ви можете вказати напрям обертання, зум, швидкість 
обертання, час патрулювання і час зупинки. Система записує маршрут і додає його до списку дій. Ви 
можете вибрати режим Keep Rotating, щоб PTZ-камера багаторазово слідувала одним і тим же 
маршрутом патрулювання. 

Додавання маршруту патрулювання 

1. На сторінці Live View натисніть Patrol на панелі інструментів. 

 

2. Натисніть . 
3. На сторінці Add Patrol введіть ідентифікатор і назву маршруту, а потім натисніть Add для 

додавання дії патрулювання. Можна додати до 64 дій. Якщо вибрано тип дії Move Direction і Zoom, 
кожен рядок включає дві дії, таким чином, можна задати лише 32 подвійних дії. Для зміни 
послідовності дій використовуйте відповідні кнопки. 

Дії патрулювання включають:  

 рух до пресету, зупинку на деякий час після досягнення пресету і рух до наступного пресету; 

 поворот із заданою швидкістю в заданому напрямку протягом певного періоду часу, зум, зупинку 
в заданому положенні на певний час або багаторазове патрулювання, якщо вибраний режим Keep 
Rotating. 

Рекомендується вибрати Go to Preset як перший тип дії. 

4. Натисніть OK. 
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Запис маршруту патрулювання 

1. На сторінці Live View натисніть Patrol на панелі інструментів. 

 

2. Щоб почати запис маршруту патрулювання, натисніть . Ви можете змінювати напрям і зум 

камери під час запису. Система записує рух і маршрут камери, а потім додає їх до списку дій. 

3. Щоб завершити запис, натисніть . Після цього маршрут патрулювання автоматично зберігається 
як бажаний. Ви можете натиснути , щоб запустити патрулювання, або , щоб видалити 
бажаний маршрут. 

 

1

2
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Складання плану патрулювання 

1. На сторінці Live View натисніть Patrol на панелі інструментів. 

 

2. Натисніть . Відкриється сторінка для складання планів патрулювання. 

3. Встановіть час і маршрут патрулювання. 

4. Виберіть Enable Patrol Plan. 

5. Натисніть OK. 

Запуск маршруту патрулювання 

Після додавання маршрутів патрулювання виберіть маршрут для початку патрулювання. 

1. На сторінці Live View натисніть Patrol на панелі інструментів. 

 
2. Натисніть  для маршруту патрулювання, який ви хочете запустити. 

1

2

1
2



96 

Зміна маршруту патрулювання 

1. На сторінці Live View натисніть Patrol на панелі інструментів. 

 

2. Натисніть  для маршруту патрулювання, який ви хотите редагувати, і змініть налаштування 
відповідно до ваших потреб. 

Видалення маршруту патрулювання 

1. На сторінці Live View натисніть Patrol на панелі інструментів. 

 

2. Натисніть  для маршруту патрулювання, який ви хотите видалити, і підтвердіть видалення. 

Встановлення початкового положення 
PTZ-камера повернеться в початкове положення, якщо жодної дії не буде виконано протягом заданого 
періоду часу. 

1
2

1
2
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 ПРИМІТКА! 
 Ця функція доступна лише для мережевих PTZ-камер. 
 Спочатку ви повинні додати пресет або маршрут патрулювання. Для отримання детальної інформації 

див.  розділи Додавання пресету і  Додавання маршруту патрулювання. 

 

1. Натисніть Setup > PTZ > Home Position. 

 
2. Виберіть режим і ідентифікатор. 

3. Натисніть кнопку Save для збереження. 

Дистанційне керування PTZ 

Коли використовується стороння платформа, і протокол PTZ несумісний з нею, ви можете увімкнути 
функцію дистанційного керування PTZ. 

 ПРИМІТКА! 
Дана функція підтримується лише PTZ-камерами. 

 

1. Натисніть Setup > PTZ > Remote Control. 

 
2. Для активації функції Remote Control виберіть On. Вкажіть порт прослуховування і код адреси. У 

таблиці нижче описано деякі основні параметри. 

Скорочення Опис 

Порт прослуховування Локальний порт камери, не зайнятий для інших цілей. Змінюйте значення 
за замовчуванням лише за необхідності. 

Код адреси 
Камера може знайти код адреси, що міститься в командах. Камера виконує 
команду лише тоді, коли код адреси в команді збігається з кодом адреси, 
що вказаний тут. 

 

3. Натисніть кнопку Save для збереження. 

Межа PTZ 

Встановіть межі обертання, щоб PTZ-камера не зіштовхнулася з перешкодами, такими як стіни. 

 ПРИМІТКА! 
Дана функція підтримується лише деякими моделями PTZ-камер. 

 

1. Натисніть Setup > PTZ > PTZ Limit.  
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2. Щоб повернути камеру в задане положення, використовуйте кнопки зі стрілками. 

3. Натисніть  для встановлення поточного положення як обмеження. Наприклад, натисніть  

вгорі, щоб встановити верхню межу. Натискання значка  призведе до повороту камери в 

поточне положення, якщо напрямок було змінено. 

4. Повторіть вищенаведені кроки, щоб встановити всі обмеження по мірі необхідності (зверху, знизу, 
зліва і справа). 

5. Натисніть кнопку Save для збереження. 

6. Натисніть Start PTZ Limit для застосування налаштувань. 

7. Натисніть , щоб скинути налаштування і встановити межу знову. 

Відновлення патрулювання 
1. Натисніть Setup > PTZ > Patrol. 

 

2. Вкажіть час відновлення патрулювання. 

3. Натисніть кнопку Save для збереження. 

 

1

2

3

4
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7  Розпізнавання номерних знаків 

 ПРИМІТКА! 
 Дана функція доступна лише в деяких моделях. 

 

Розпізнавання номерних знаків у реальному часі 

1. Для камер зі встановленою картою Micro SD знімки будуть збережені на SD-карту. Якщо SD-карта 
не встановлена, знімки будуть збережені на ПК. Для перегляду знімків натисніть Open Image 
Folder. Зображення знака крупним планом буде представлено у верхній лівій панелі. 

2. Для видалення всіх знімків натисніть Clear All Records. 

 

Налаштування розпізнавання номерних знаків у реальному часі 

Позначення зони виявлення 

1. Натисніть Setup > Intelligent> Traffic Monitoring. Натисніть Draw Detection Rules. 
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2. Натисніть Draw Detection Rules і намалюйте зону виявлення на знімку. 

 
3. Натисніть Inclination Line і накресліть лінію, що показує нахил поверхні дороги. 

 
Скинути лічильник потоку 

Натисніть Setup > Intelligent > Traffic Monitoring > Smart > Reset Flow Counting. Встановіть час 
скидання знімка розпізнаного номерного знака. 

 

Інтелектуальна обробка знімків 

Натисніть Setup > Intelligent > Traffic Monitoring > Snapshot Handling. Зазвичай рекомендується 
використовувати налаштування за замовчуванням. 
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Нерозпізнані транспортні засоби: виберіть, чи потрібно генерувати облік проходження 
нерозпізнаних транспортних засобів. Ця функція за замовчуванням увімкнена. 

Зроблені фотографії: виберіть, чи потрібно відображати номерний знак крупним планом. За 
замовчуванням відображення увімкнено. 

Фотографія 

Натисніть Setup > Intelligent > Traffic Monitoring > Photo. На цій сторінці можна налаштувати 
екранний інтерфейс. 

 
 

Компонент Опис 

Одне фото 
Колір шрифта: колір тексту екранного інтерфейсу. 

Колір фону: колір фону екранного інтерфейсу. 

Розмір шрифту Встановіть розмір шрифту. 

Відстань між знаками Встановіть відстань між знаками екранного інтерфейсу.  

Формат часу Встановіть формат часу. 

Формат дати Встановіть формат дати. 

Пункти екранного інтерфейсу 
Виберіть пункти екранного інтерфейсу. 

Після вибору пунктів можна завершити детальне налаштування 
екранного інтерфейсу для кожного пункту шляхом редагування. 
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Додаток A. Глосарій 

Скорочення Опис 

ARP Протокол перетворення адрес 

CBR Постійна швидкість потоку 

DNS Служба доменних імен 

DDNS Динамічна служба доменних імен 

DHCP Протокол динамічного конфігурувания вузла 

DST Перехід на літній час 

FTP Протокол передачі файлів 

GOP Група зображень 

GUI Графічний інтерфейс користувача 

HTTPS Протокол передачі гіпертексту по SSL 

IE Браузер Internet Explorer 

IMOS Мультимедійна операційна система IP 

IP Протокол міжмережевої взаємодії 

IPC IP-камера 

MTU Максимальна одиниця передачі 

NTP Мережевий протокол часу 

OSD Екранний інтерфейс 

PoE Подача живлення по мережі Ethernet 

PPPoE Метод передачі даних протоколу одноточкових з'єднань по мережі 
Ethernet 

PTZ Поворот, нахил і зум 

ROI Область інтересу 

SMTP Простий протокол пересилання електронної пошти 

SSL Протокол захищених сокетів 

UNP Універсальний мережевий паспорт 

USB Універсальна послідовна шина 

VBR Змінна швидкість потоку 

WDR Широкий динамічний діапазон 
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Додаток B. Поширені запитання 

Що робити, якщо немає повідомлення з вимогою встановити ActiveX під час першого входу в 
систему на ПК з Windows 7? 

Відповідь: виконайте наведені нижче дії, щоб вимкнути UAC, а потім увійдіть в систему знову.  

1. Натисніть кнопку Start, а потім натисніть Control Panel. 

2. У вікні пошуку введіть контроль облікових записів, а потім натисніть Change User Account Control 
Settings .  

3. Перемістіть повзунок у положення Never Notify, а потім натисніть ОК.  

4. Після вимикання контролю облікових записів знову увійдіть в систему. 

 

Що робити, якщо встановлення ActiveX завершилось невдачею? 

Відповідь: якщо встановлення виконати не вдалося, додайте IP-адресу камери до списку надійних 
сайтів: відкрийте Internet Option в браузері Internet Explorer. Відкрийте вкладку Security, натисніть 
Trusted sites, а потім натисніть Sites для додавання веб-сайту. 

Якщо ви використовуєте Windows 7, спочатку збережіть файл setup. exe на ПК, а потім клікніть на цьому 
файлі правою кнопкою миші, виберіть опцію Run as administrator і встановіть програму відповідно до 
інструкцій на екрані. 

 

Що робити, якщо при першому вході в систему не запускаєтся режим перегляду відео в реальному 
часі? 

Відповідь: закрийте брандмауер на своєму ПК, а потім знову увійдіть у веб-інтерфейс. 

 


	1   Підключення до мережі
	2    Вхід в систему
	Перевірка перед входом в систему
	Додайте IP-адресу як адресу надійного сайту
	Змінена параметрів керування доступом користувачів (необов'язково)
	Вхід у веб-інтерфейс
	1. Перейдіть на сторінку входу, ввівши IP-адресу вашої камери в рядок пошуку.
	2. Якщо ви входите в систему вперше, дотримуйтесь інструкцій на екрані та встановіть ActiveX. Для завершення установки необхідно закрити браузер.
	3. При першому вході користувача на екрані відображається політика конфіденційності. Ознайомившись з політикою конфіденційності, поставте галочку біля пункту «Я приймаю умови цієї політики», а потім натисніть кнопку OK, щоб перейти до наступного кроку.
	4. Введіть ім'я користувача і пароль, а потім натисніть на кнопку Login. Для першого входу використовуйте ім'я користувача за замовчуванням admin і пароль "123456".

	Загальні відомості про веб-інтерфейс
	Початкове налаштування

	3   Налаштування параметрів
	Локальні параметри
	1. Виберіть команди Setup > Common > Local Settings.
	2. Змініть налаштування відповідно до ваших потреб. У наведеній нижче таблиці описано деякі основні параметри.
	3. Натисніть кнопку Save для збереження.

	Налаштування мережі
	Інтерфейс Ethernet
	Статична IP-адреса
	4. Натисніть Setup > Network > Network.
	5. У випадаючому списку Obtain IP Address оберіть пункт Static.
	6. Введіть IP-адресу, маску підмережі і адресу шлюзу за замовчуванням. Переконайтеся, що IP-адреса камери унікальна в мережі.
	7. Натисніть кнопку Save для збереження.

	PPPoE
	1. Натисніть Setup > Network > Network.
	2. У випадаючому списку Obtain IP Address виберіть пункт PPPoE.
	3. Введіть ім'я користувача і пароль, надані вашим інтернет-провайдером (ISP).
	4. Натисніть кнопку Save для збереження.

	DHCP
	1. Натисніть Setup > Network > Network.
	2. У випадаючому списку Obtain IP Address оберіть пункт DHCP.
	3. Натисніть кнопку Save для збереження.

	IPv6
	1. Натисніть Setup > Network > Network.
	2. За замовчуванням для режиму IPv6 встановлена опція Manual.
	3. Введіть адресу IPv6, задайте довжину префіксу і шлюз за замовчуванням. IP-адреса повинна бути унікальною в мережі.
	4. Натисніть кнопку Save для збереження.

	Wi-Fi
	1. Натисніть Setup > Network > Network. Відкрийте вкладку Wi-Fi.
	2. Виберіть Sniffer.
	3. Натисніть кнопку Save для збереження.
	1. Виберіть Setup > Network > Network. Виберіть Wi-Fi для Wi-Fi Mode.
	2. Відобразиться рівень сигналу. Ввімкніть Adaptive Streams. На сторінці показано, що є й інші мережі Wi-Fi. Щоб знову шукати мережі Wi-Fi, натисніть Search.
	3. Натисніть назву (SSID) у списку мереж Wi-Fi. Відобразиться інформація про відповідну мережу.
	4. Натисніть кнопку Save для збереження.
	5. Якщо для режиму Wi-Fi Mode вибрано значення Wi-Fi Hotspot, камера може функціонувати як точка доступу Wi-Fi для інших пристроїв.
	6. Натисніть кнопку Save для збереження.


	Порт
	1. Натисніть Setup > Network > Port.
	2. Задайте відповідні номери портів.
	3. Натисніть кнопку Save для збереження.

	FTP
	Загальні характеристики
	1. Натисніть Setup > Storage > FTP. Перейдіть на вкладку General.
	2. Вкажіть IP-адресу і порт для FTP сервера, ім'я користувача та пароль, які використовуються для завантаження зображень на сервер FTP, виберіть Upload Images, Overwrite Storage і задайте значення Overwrite At (поріг для перезапису зображень). Деякі м...
	3. Задайте шлях для збереження знімків на сервер FTP та формат імені файла. Наприклад, задайте шлях як № предустановки \\IP-адреса\\дата\\час і встановіть ім'я файлу як № предустановки-зум PTZ-широта PTZ-довгота PTZ.jpg.
	4. Натисніть кнопку Save для збереження.

	Smart
	1. Натисніть Setup > Storage > FTP. Перейдіть на вкладку Smart.
	2. Вкажіть IP-адресу і порт для FTP сервера, ім'я користувача та пароль, які використовуються для завантаження зображень на сервер FTP.
	3. Задайте шлях для збереження знімків на сервер FTP і формат імені файла. Наприклад, задайте шлях як № предустановки \\IP-адреса\\дата\\час і встановіть ім'я файлу як № предустановки-зум PTZ-широта PTZ-довгота PTZ.jpg.
	4. Натисніть кнопку Save для збереження.


	Електронна пошта
	1. Натисніть Setup > Network > E-mail.
	2. Встановіть відповідні параметри для відправника і одержувача. Деякі моделі камер підтримують тестування електронної пошти. Ви можете перевірити електронну пошту після введення адреси одержувача. У наведеній нижче таблиці описано деякі основні парам...
	3. Натисніть кнопку Save для збереження.

	Перемикання портів
	1. Натисніть Setup > Network > Port. Перейдіть на вкладку Port Mapping.
	2. Активуйте Port Mapping і виберіть тип відображення. Якщо вибрана опція Manual, тоді мають бути задані зовнішні порти (зовнішня IP-адреса отримується камерою автоматично). Якщо вибраний порт зайнятий, стан (Status) буде відображатися як неактивний.
	3. Натисніть кнопку Save для збереження.

	DNS
	1. Натисніть Setup > Network > DNS.
	2. Вкажіть адресу сервера DNS.
	3. Натисніть кнопку Save для збереження.

	DDNS
	1. Натисніть Setup > Network > DDNS.
	2. Активуйте службу DDNS Service.
	3. Виберіть тип DDNS: DynDNS, NO-IP або EZDDNS.
	4. Задайте інші параметри, включаючи адресу сервера, доменне ім'я, ім'я користувача і пароль.
	5. Натисніть кнопку Save для збереження.

	EZCloud
	1. Натисніть Setup>Network>EZ Cloud.
	2. Для активації хмарного сервісу виберіть On.
	3. Натисніть кнопку Save для збереження.

	SNMP
	1. Натисніть Setup> Network > SNMP

	802.1x
	1. Натисніть Setup > Network > 802.1x.
	2. Виберіть On, а потім виконайте інші налаштування.
	3. Натисніть кнопку Save для збереження.

	QoS
	1. Натисніть Setup > Network > QoS.
	2. Встановіть рівень пріоритету (0–63) для кожної служби. В даний час QoS дозволяє призначати різні рівні пріоритету для аудіо і відео, сигналів тривоги, управління конфігурацією і передачі по FTP. Чим вище значення, тим вище пріоритет. Наприклад, якщ...
	3. Натисніть кнопку Save для збереження.


	Налаштування зображення
	Налаштування параметрів зображення
	Параметри сцени
	1. Натисніть Scenes.
	2. Виберіть сцену, а потім встановіть параметри перемикання сцен. У таблиці нижче описано деякі основні параметри.
	3. Виберіть сцену і потім клацніть , щоб задати її як сцену за замовчуванням.
	4. Якщо вибрано режим автоматичного перемикання, система автоматично перейде до сцени, якщо виконуються умови перемикання на сцену, відмінну від сцени за замовчуванням. В іншому випадку камера продовжить використовувати сцену за замовчуванням. Коли ав...

	Покращення зображення
	1. Натисніть Setup > Image > Image, а потім виберіть Image Enhancement.
	2. Щоб змінити налаштування, скористайтеся повзунками. Ви також можете ввести значення безпосередньо. У таблиці нижче описано деякі основні параметри.
	3. Щоб відновити налаштування за замовчуванням у цій області, натисніть Default.

	Експозиція
	1. Натисніть Setup > Image > Image, а потім виберіть Exposure.
	2. Змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні параметри.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.

	Розумне підсвічування
	1. НатиснітьSetup > Image > Image, а потім виберіть Smart Illumination.
	2. Виберіть відповідний режим управління ІЧ-підсвічуванням і встановіть параметри. У таблиці нижче описано деякі основні параметри.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.

	Фокус
	1. Натисніть Setup > Image > Image, а потім виберіть Focus.
	2. Оберіть необхідний режим фокусування.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.

	Баланс білого
	1. Натисніть Setup > Image > Image, а потім виберіть White Balance.
	2. Виберіть необхідний режим балансу білого. У таблиці нижче описано деякі основні параметри.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.

	Додатково
	1. Натисніть Setup > Image > Image, а потім виберіть Advanced.
	2. Увімкніть функцію антитуману, а потім виберіть рівень  для сцени. Рівень 9 відповідає максимальному ефекту антитуману, а рівень 1 - мінімальному.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.

	Тип освітлення
	1. Натисніть Setup > Image > Image, а потім виберіть Smart Illumination.
	2. Виберіть опцію з випадаючого списку Lighting Type.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.

	Вибір режиму діафрагми і об’єктива
	1. Натисніть Setup > Image > Image, а потім виберіть Advanced.
	2. Змініть налаштування відповідно до ваших потреб. У наведеній нижче таблиці описано деякі основні параметри.
	3. Щоб відновити налаштування за замовчуванням, натисніть Default.


	Налаштування екранного інтерфейсу
	1. Натисніть Setup > Image > OSD.
	2. Виберіть вміст екранного інтерфейсу і місце його розташування на екрані.
	3. Після виконання налаштування з’явиться повідомлення про успішне завершення цієї операції.

	Режим маскування
	1. Натисніть Setup > Image > Privacy Mask.
	2. Щоб додати маску конфіденційності, натисніть . Щоб видалити маску, натисніть .
	3. Виберіть режим маскування. По необхідності можна обрати стандартний і нестандартний режим. У нестандартному режимі при повороті камери PTZ форма маски конфіденційності змінюється разом з формою замаскованого об'єкта на зображенні.


	Налаштування аудіо і відео
	Конфігурація відео
	1. Натисніть Setup > Video & Audio > Video.
	2. Змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні параметри.
	3. Натисніть кнопку Save для збереження.

	Налаштування аудіоканалу
	1. Натисніть Setup > Video & Audio > Audio.
	2. Змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні параметри.
	3. Натисніть кнопку Save для збереження.

	Створення знімків.
	1. Натисніть Setup > Video & Audio > Snapshot.
	2. Виберіть On, а потім виберіть роздільну здатність, максимальний розмір і розклад відповідно до ваших потреб. Опис деяких параметрів наведено нижче.
	3. Натисніть кнопку Save для збереження.

	ROI
	1. Натисніть Setup > Video & Audio > ROI.
	2. Натисніть , а потім скористайтеся перетягуванням мишею для покриття заданої частини зображення. Для видалення виберіть область, а потім натисніть .

	Налаштування потоку медіаданих
	Потік медіаданих
	1. Натисніть Setup > Video & Audio > Media Stream.
	2. Натисніть , виберіть тип потоку, а потім задайте IP-адресу і номер порту одноадресної або багатоадресної групи для пристрою декодування, який приймає аудіо- та відеопотоки від камери.
	3. Для видалення потоку натисніть .
	4. Натисніть Submit для завершення операцій.

	Адреса RTSP Multicast
	1. Натисніть Setup > Video & Audio > Media Stream > RTSP Multicast Address.
	2. Задайте адресу багатоадресної передачі (від 224.0.0.0 до 239.255.255.255) і номер порту (від 0 до 65 535).
	3. Натисніть кнопку Save для збереження.



	Налаштування розумної сигналізації
	Розумні налаштування
	Виявлення перетину лінії
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Cross Line і натисніть .
	2. Виберіть Cross Line Detection.
	3. У розділі Detection Rule натисніть  , щоб додати нову область виявлення. Для видалення області виявлення натисніть .
	4. У маленькому вікні попереднього перегляду протягніть лінію до наміченої позиції і задайте діапазон виявлення.
	5. Задайте напрям і чутливість, при якій камера має сигналізувати про перетин лінії.
	6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	7. Натисніть кнопку Save для збереження.

	Виявлення вторгнень
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Intrusion і натисніть .
	2. Виберіть Intrusion Detection.
	3. У розділі Detection Rule натисніть  щоб додати нову область виявлення. Для видалення області виявлення натисніть .
	4. Встановіть потрібні позиції і діапазон шляхом перетягування меж поля.
	5. Встановіть поріг часу, чутливість і відсотковий коефіцієнт, при яких камера повинна сигналізувати про виявлення вторгнення.
	6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	7. Натисніть кнопку Save для збереження.

	Рухомий об'єкт
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Object Moving і натисніть .
	2. Виберіть Enable Object Moving Detection.
	3. У розділі Detection Rule натисніть  щоб додати область виявлення. Для видалення області виявлення натисніть .
	4. Встановіть позиції і робочий діапазон, перетягнувши рамку.
	5. Встановіть поріг часу та чутливість, при яких камера має сигналізувати про виявлення вторгнень.
	6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	7. Натисніть кнопку Save для збереження.

	Залишений об'єкт
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Object Left і натисніть .
	2. Виберіть Enable Object Left Detection.
	3. У розділі Detection Rule натисніть  щоб додати область виявлення. Для видалення натисніть .
	4. Встановіть позиції і робочий діапазон, перетягнувши рамку.
	5. Встановіть поріг часу та чутливість, при яких камера має сигналізувати про виявлення вторгнень.
	6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	7. Натисніть кнопку Save для збереження.

	Виявлення облич
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Face і натисніть .
	2. Встановіть потрібні позиції і діапазон шляхом перетягування меж.
	3. Налаштуйте параметри виявлення відповідно до фактичних потреб.
	4. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	5. Натисніть кнопку Save для збереження.
	6. Натисніть Start Intelligent Analysis.

	Підрахунок людей
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть People Counting і натисніть .
	2. Виберіть Enable Passenger Flow Detection. Виберіть спосіб виявлення, встановіть інтервал відправки сигналу і чутливість.
	3. Натисніть Draw Detection Area, а потім намалюйте область виявлення (наприклад, квадрат) у вікні попереднього перегляду ліворуч.
	4. Натисніть Draw Entrance Direction, а потім позначте напрямок у вікні попереднього перегляду ліворуч. Напрямок зазвичай буває вертикальним або під нахилом.
	5. У розділі Filter by Object Size встановіть значення для Max. Size и Min. Size. Враховуватися будуть тільки ті об'єкти, які потрапляють в заданий діапазон розмірів, всі інші будуть відфільтровані. Максимальна ширина або висота мають бути більшими за...
	6. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	7. Для скидання результатів підрахунку натисніть Clear Counting Result.
	8. Натисніть кнопку Save для збереження.

	Автоматичне стеження
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Auto Tracking і натисніть .
	2. Встановіть тайм-аут відстеження (у секундах) і коефіцієнт зуму.
	3. Натисніть кнопку Save для збереження.

	Теплова карта
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Heat Map і натисніть .
	2. Встановіть галочку в поле Enable.
	3. Задайте Background Update Rate. Чим вище значення, тим швидше оновлюється зображення.
	4. Задайте Sensitivity. Чим вище значення, тим більша ймовірність виявлення малих об'єктів.
	5. Задайте Min. Object Size. Чим вище значення, тим більше малих об'єктів не буде виявлено.
	6. Задайте інтервал оновлення статистичного звіту на платформі.
	7. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	8. Натисніть кнопку Save для збереження.

	Виявлення розфокусування
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Defocus і натисніть .
	2. Виберіть Defocus Detection.
	3. Налаштуйте чутливість виявлення та дії по сигналу тривоги відповідно до ваших вимог. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	4. Натисніть кнопку Save для збереження.

	Виявлення зміни сцени
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Scene Change і натисніть .
	2. Виберіть Scene Change Detection.
	3. Задайте чутливість виявлення. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	4. Натисніть кнопку Save для збереження.

	Додаткові налаштування
	Параметри фото
	1. Натисніть Setup > Intelligent > Advanced Settings. Відкрийте вкладку Photo parameters.
	2. Налаштуйте чіткість мініатюри зображення.
	3. Натисніть кнопку Save для збереження.

	Параметри виявлення
	1. Натисніть Setup > Intelligent > Advanced Settings. Відкрийте вкладку Detection parameters.
	2. Виберіть режим виявлення. Виберіть Filter Repeated Motion Mode щоб запобігти передачі повторних сигналів тривоги при повторному виявленні руху в зоні контролю.
	3. Натисніть кнопку Save для збереження.


	З’єднання корпусної і купольної камери
	1. Натисніть Setup > Intelligent > Smart Settings. Виберіть Box-Dome Linkage, натисніть  і виберіть вкладку Linkage Parameter.
	2. Встановіть галочку в поле Enable Box-Dome Linkage.
	3. Задайте головну або підпорядковану IP-адресу, HTTP-порт і коефіцієнт масштабування.
	4. Натисніть кнопку Save для збереження.
	5. Виберіть вкладку Mark Linkage.
	6. Натисніть Manual Mark, відобразиться наступна сторінка. Призначення кнопок:
	Попередній/наступний: змінити розмітку сцени після завершення розмітки на поточній сцені.
	Кінцева мітка: завершення розмітки без збереження.
	Додати/Видалити: додати або видалити точку розмітки.
	Видалити все: видалити усі точки розмітки на цій сторінці.
	7. Етапи нанесення розмітки на одній сторінці: натисніть Add, а потім натисніть на зображенні лівої головної камери. При натисканні з'явиться невелика біла рамка і область автоматично збільшиться (як показано нижче). Для підтвердження поточної точки р...
	8. Поверніть підпорядковану камеру в положення, де розташована точка розмітки. Встановіть максимальне збільшення для підлеглої камери, і намалюйте хрест в центрі зображення цієї камери, який збігається з точкою розмітки (маленькою білою рамкою) на зоб...
	9. Натисніть на інше місце на зображенні основної камери і повторіть останній крок. Може знадобитися 5-12 точок розмітки, в залежності від потреби. Щоб перейти до наступної сцени, натисніть Finish і Next.
	10. Коли налаштування розмітки завершено, натисніть Apply. Для мультисенсорних камер натисніть кнопку після того як буде виконане налаштування розмітки чотирьох сцен.


	Налаштування загальних сигналів тривоги
	Налаштування параметрів сигналізації детекції руху
	Область виявлення
	1. Натисніть Setup > Events > Common Alarm > Motion Detection. Встановіть для параметра Detection Mode значення Area.
	2. У розділі Detection Area натисніть  щоб додати нову область виявлення. Для видалення області виявлення натисніть .
	3. Задайте область виявлення, використовуючи функцію перетягування миші.
	4. Генерація сигналу тривоги  камерою при виявленні руху також залежить від наступних параметрів: чутливості виявлення, розміру об'єкта і історії подій. Ці параметри мають бути встановлені користувачем.
	5. Налаштування параметрів сигналізації.
	a. той же самий сигнал тривоги не буде активований протягом вказаного часу, цей сигнал тривоги буде  скинутий. Після скидання знову буде  можлива  відправка сигналу тривоги такого типу.
	b. Якщо той же самий сигнал тривоги  буде активований протягом вказаного часу, цей сигнал тривоги не  буде скинуто, поки не закінчиться час ігнорування цього сигналу. Після цього той же  самий сигнал тривоги  може бути відправлено знову.

	6. Вкажіть дії, які запускаються по сигналу детекції руху, і складіть план.
	7. Натисніть кнопку Save для збереження.

	Детекція по сітці
	1. Натисніть Setup > Events > Motion Detection. Встановіть для параметра Detection Mode значення Grid.
	2. Області виявлення на сітці можуть мати неправильну форму.
	3. Задайте чутливість, при якій камера надсилатиме сигнал тривоги, виявивши рух (сигнали тривоги можна переглядати на сумісному відереєстраторі).
	4. Налаштування параметрів сигналізації.
	a. той же самий сигнал тривоги не буде активований протягом вказаного часу, цей сигнал тривоги буде  скинутий. Після скидання знову буде  можлива  відправка сигналу тривоги такого типу.
	b. Якщо той же самий сигнал тривоги  буде активований протягом вказаного часу, цей сигнал тривоги не  буде скинуто, поки не закінчиться час ігнорування цього сигналу. Після цього той же  самий сигнал тривоги  може бути відправлено знову.

	5. Вкажіть дії, які запускаються по сигналу детекції руху, і складіть план. Для отримання детальної інформації див. опис дій по сигналу тривоги у підрозділі Область виявлення розділу Налаштування параметрів сигналізації детекції руху.
	6. Натисніть кнопку Save для збереження.


	Налаштування параметрів сигналізації при сторонньому втручанні
	1. Натисніть Setup > Events > Common Alarm >Tampering Alarm.
	2. Виберіть для параметра Tampering Alarm значення On.
	3. Налаштуйте чутливість і період часу, протягом якого камера має сигналізувати про несанкціоноване втручання.
	4. Налаштуйте дії по сигналу тривоги про стороннє втручання і складіть план. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	5. Натисніть кнопку Save для збереження.

	Налаштування параметрів сигналізації по звуку
	1. Натисніть Setup > Events > Common Alarm >Audio Detection.
	2. Виберіть для параметра Audio Detection значення Enable. Виберіть тип виявлення і встановіть межі відмінності або поріг. Щоб відключити тривогу по звуку, зніміть галочку Enable.
	3. Налаштуйте дії по сигналу тривоги і розклад постановки на охорону відповідно до своїх потреб. Щоб дізнатися більше, див. опис дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	4. Натисніть кнопку Save для збереження.

	Налаштування параметрів тривожного входу
	1. Натисніть Setup > Events > Common Alarm > Alarm Input.
	2. Виберіть сигнал тривоги і дайте йому назву.
	3. Виберіть N.O. або N.C. відповідно до типу тривожного виходу пристрою стороннього виробника. Наприклад, якщо тривожний вихід пристрою стороннього виробника в звичайному стані відкритий, слід вибрати N.O., щоб камера могла отримувати сигнали  тривоги...
	4. Налаштуйте дії по сигналу тривоги з тривожного входу і складіть план. Щоб дізнатися більше, див. описи дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	5. Натисніть кнопку Save для збереження.

	Налаштування параметрів тривожного виходу
	1. Натисніть Setup > Events > Common Alarm > Alarm Output.
	2. Виберіть сигнал тривоги і дайте йому назву.
	3. Встановіть статус N.O. (налаштування за замовчуванням) і встановіть тривалість сигналу тривоги.
	4. Встановіть режим ретрансляції для кращої адаптації до сторонніх тривожних пристроїв, наприклад сигнальних ламп. Виберіть режим очікування відповідно до сторонного тривожного пристрою.
	5. Налаштуйте дії по сигналу тривоги з тривожного виходу і складіть план. Щоб дізнатися більше, див. опис дій по сигналу тривоги в Налаштування параметрів сигналізації детекції руху.
	6. Натисніть кнопку Save для збереження.


	Збереження даних на карту пам'яті
	Налаштування параметрів локальної пам'яті
	Збереження даних вручну
	1. Натисніть Setup > Storage > Storage.
	2. Активуйте локальну пам'ять і змініть налаштування відповідно до ваших потреб. У таблиці нижче описано деякі основні параметри.
	3. Натисніть кнопку Save для збереження.

	Розклад запису
	1. Натисніть Setup > Storage > Storage.
	2. Виберіть Planned Storage, а потім встановіть періоди, протягом яких камера повинна записувати відео на карту пам'яті.
	3. Натисніть кнопку Save для збереження.


	Налаштування подальшого запису в кеш
	Відключення локальної пам'яті
	1. Натисніть Setup > Storage > Storage.
	2. В полі Storage Policy виберіть Off. Запис після події відображається, якщо камера оснащено цією функцією. У такому випадку задайте Post-Record(s).
	3. Натисніть кнопку Save для збереження.



	Обслуговування системи
	Безпека
	Керування користувачами
	Налаштування безпечної передачі даних
	1. Натисніть Setup > Network > Port.
	2. Введіть номер порту в текстове поле HTTPS Port.
	3. Натисніть кнопку Save для збереження.
	4. Натисніть Setup > Security > Network Security > HTTPS.
	5. Виберіть для HTTPS значення On. При необхідності ви можете імпортувати сертифікат користувача SSL.
	6. Натисніть кнопку Save для збереження.

	Автентифікація
	1. Натисніть Setup > Security > Network Security > Authentication.
	2. Виберіть режим автентифікації і натисніть Save.

	Приховування інформації постачальника
	1. Натисніть Setup > Security > Registration Info.
	2. Встановіть для параметра Registration Info значення On.
	3. Натисніть кнопку Save для збереження.

	Захист APR
	1. Натисніть Setup > Security > Network Security > ARP Protection.
	2. Встановіть мітку, щоб включити функцію прив'язки ARP, і задайте MAC-адресу шлюзу.
	3. Натисніть кнопку Save для збереження.

	Фільтр IP-адрес
	1. Натисніть Setup > Security > Network Security > IP Address Filtering.
	2. Для активації фільтра IP-адрес виберіть значення On.
	3. Виберіть режим фільтрації, а потім додайте IP-адреси.
	4. Натисніть кнопку Save для збереження.

	Політика доступу
	1. Натисніть Setup > Security > Network Security > Access Policy.
	2. Щоб активувати зручний пароль і автентифікацію MAC, виберіть значення On.
	3. Натисніть кнопку Save для збереження.

	Водяний знак
	1. Натисніть Setup > Security > Watermark.
	2. Виберіть On, щоб активувати водяний знак, а потім введіть його вміст.
	3. Натисніть кнопку Save для збереження.


	Встановлення системного часу
	Встановлення або синхронізація системного часу вручну
	1. Натисніть Setup > Common > Time, а потім відкрийте вкладку Time.
	2. Виберіть метод синхронізації.
	3. Встановіть свій часовий пояс і системний час. Ви можете також натиснути Sync with Computer Time для синхронізації часу камери з часом ПК.
	4. Натисніть кнопку Save для збереження.

	Синхронізація з сервером NTP
	1. Натисніть Setup > Common > Time, а потім відкрийте вкладку Time.
	2. Встановіть для параметра Sync Mode значення Sync with NTP Server, а потім задайте IP-адресу і порт сервера NTP, а також інтервал оновлення.
	3. Натисніть кнопку Save для збереження. Камера буде періодично синхронізувати час з сервером NTP.

	Встановлення літнього часу
	1. Натисніть Setup > Common > Time, а потім відкрийте вкладку DST.
	2. Виберіть для DST значення On, встановіть часу початку, час завершення і зміщення літнього часу.
	3. Натисніть кнопку Save для збереження.


	Налаштування параметрів серверів
	Інтелектуальний сервер
	1. Натисніть Setup > Common > Time, а потім відкрийте вкладку Intelligent Server.
	2. Вкажіть IP-адресу сервера TM і налаштуйте інші параметри.
	3. Натисніть кнопку Save для збереження.


	Налаштування режиму послідовного порту
	Керування PTZ
	1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port.
	2. Виберіть опцію PTZ Control у випадаючому списку Port Mode. У таблиці нижче описано деякі основні параметри.
	3. Натисніть кнопку Save для збереження.

	Прозорий канал
	1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port.
	2. Виберіть опцію Trans-Channel у випадаючому списку Port Mode.
	3. Виберіть для параметра Trans-Channel значення Enable.
	4. Введіть цільову IP-адресу і номер порту (IP-адресу і номер порту, до якого підключається прозорий канал).
	5. Натисніть кнопку Save для збереження.

	OSD
	1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port.
	2. Виберіть опцію OSD у випадаючому списку Port Mode. Виберіть Enable OSD Report (щоб дані екранного інтерфейсу завантажувались на платформу).
	3. Натисніть кнопку Save для збереження.

	Прозорий канал ONVIF
	1. Натисніть Setup > System > Ports & Devices і відкрийте вкладку Serial Port.
	2. Встановіть для параметра Port Mode значення Select Trans-Channel via ONVIF.
	3. Натисніть кнопку Save для збереження.


	Керування склоочисником
	1. Натисніть Setup > System > Ports и Devices і відкрийте вкладку External Device.
	2. Задайте режим керування склоочисником. У таблиці нижче описано деякі основні параметри.

	Перегляд стану пристрою
	1. Натисніть Setup > Common > Basic Info.
	2. Натисніть Refresh для отримання останньої інформації про стан.
	3. Перегляньте інформацію про пристрій.

	Стан збереження фотографій
	1. Натисніть Photo.
	2. Натисніть Refresh для оновлення стану зберігання даних.
	3. Ви можете експортувати або видаляти фотографії у розділі Image List.

	Оновлення ПЗ пристрою
	1. Натисніть Setup > System > Maintenance.
	2. У розділі Software Upgrade натисніть Browse і виберіть файл оновлення.
	3. Натисніть Upgrade, а потім підтвердіть цю операцію для її запуску. Після завершення оновлення система перезавантажиться. Деякі пристрої підтримують оновлення програми завантаження. Для оновлення виберіть опцію Upgrade Boot Program.
	4. Ви можете натиснути Detect для пошуку нових версій, доступних через хмарне оновлення.

	Перезапуск системи
	1. Натисніть Setup > System > Maintenance.
	2. У розділі Device Restart натисніть Restart. Пристрій перезавантажиться після підтвердження цієї операції.

	Імпорт і експорт файлу конфігурації системи
	1. Натисніть Setup > System > Maintenance.
	2. Для імпорту збережених файлів конфігурації натисніть Browse поруч з кнопкою Import, виберіть файл, який потрібно імпортувати, і натисніть Import. Результат буде показаний на екрані.
	3. Для експорту поточної конфігурації системи натисніть Browse (поруч з полем Exporting), задайте місце призначення і натисніть Export.
	4. Для відновлення конфігурації за замовчуванням натисніть Default і підтвердіть цю операцію. Пристрій перезавантажиться і відновить конфігурацію за замовчуванням. При натисканні кнопки Default при встановленій галочці пристрій буде відновлено до заво...

	Збір діагностичної інформації
	1. Натисніть Setup > System > Maintenance.
	2. В полі Diagnosis Info натисніть Browse, щоб вказати місце призначення, а потім натисніть Export.

	Параметри фокусування
	1. Натисніть Setup > System > Maintenance.
	2. У розділі Focus задайте значення для параметрів Min. Focus Distance (у см) і Max. Zoom Ratio.
	3. Натисніть OK.

	Висота встановлення пристрою
	1. Натисніть Setup > System > Maintenance.
	2. Введіть фактичну висоту купола інфрачервоного підсвічування до землі.
	3. Натисніть OK.

	Параметри камер FishEye
	1. Натисніть Live View > Mount. Виберіть спосіб монтажу. Вибраний спосіб монтажу має співпадати з фактичним способом монтажу.
	2. Налаштуйте параметри. У таблиці нижче описано деякі основні параметри.



	4   Перегляд у реальному часі
	Панель інструментів живого перегляду
	Перегляд певної області зображень
	Використання цифрового зуму
	1. На сторінці Live View натисніть значок  на панелі інструментів.
	2. Натиснувши і утримуючи кнопку миші, перемістіть курсор зверху вниз (намалюйте прямокутник), щоб встановити область. Щоб відновити розмір оригінального зображення і збільшити масштаб інших його областей,  клацніть правою кнопкою миші.
	3. Щоб вийти, натисніть значок .

	Використання фокусування зони
	1. На сторінці Live View натисніть значок  на панелі інструментів.
	2. Натиснувши і утримуючи кнопку миші, перемістіть курсор зверху вниз (намалюйте прямокутник), щоб встановити область.
	3. Щоб вийти, натисніть значок .

	Використання 3D-позиціонування
	1. На сторінці Live View натисніть значок  на панелі інструментів.
	2. Натиснувши і утримуючи кнопку миші, перемістіть курсор зверху вниз (намалюйте прямокутник), щоб встановити область. Перетягування у зворотньому напрямі (знизу вгору) зменшує масштаб.
	3. Щоб вийти, натисніть значок .


	Живий перегляд з камер FishEye
	Функція 5ePTZ панорамних камер
	1. На сторінці Live View натисніть значок  на панелі інструментів, як показано нижче.
	2. При натисканні на значок  в режимі панорами живий прегляд переключиться в режим стеження 5ePTZ. Потім камера буде визначати рухомі об'єкти в режимі живого перегляду, коли увімкнено функцію захисту периметру. Крім того, вона може відстежувати і збіл...
	3. Для переходу в режим панорами натисніть кнопку  в режимі стеження 5ePTZ.


	5   Відтворення відео і його завантаження в локальну пам'ять
	Відтворення відео
	1. Натисніть Playback на домашній сторінці.
	2. Виберіть дату в календарі.
	3. Натисніть Query.
	4. У розділі Results двічі натисніть період часу, щоб почати відтворення запису.

	Завантаження
	1. Натисніть Playback на домашній сторінці.
	2. Пошук відео в заданий період часу. Результати будуть показані в списку.
	3. Виберіть відео і натисніть Download. Відео буде завантажено в локальну папку з карти пам'яті (шлях до локальної папки можна змінити в меню Local Settings).
	4. Натисніть Open, щоб відкрити папку, в яку було збережено завантажене відео.


	6   Керування PTZ
	Панель інструментів для керування PTZ
	Налаштування патрулювання за допомогою пресетів
	Налаштування пресетів
	Додавання пресету
	1. На сторінці Live View натисніть Preset на панелі інструментів.
	2. Змініть положення камери, щоб вона мала потрібний напрям огляду.
	3. Налаштуйте зум і фокус для отримання оптимального зображення.
	4. Для додавання цих налаштувань як пресету натисніть . Введіть номер і назву пресету, а потім натисніть OK.

	Перехід до пресету
	1. На сторінці Live View натисніть Preset на панелі інструментів.
	2. Щоб перейти до пресету, натисніть . PTZ-камера буде використовувати вибраний пресет.

	Видалення пресету.
	1. На сторінці Live View натисніть Preset на панелі інструментів.
	2. Натисніть  для пресету, а потім підтвердіть видалення.


	Налаштування патрулювання
	Додавання маршруту патрулювання
	1. На сторінці Live View натисніть Patrol на панелі інструментів.
	2. Натисніть .
	3. На сторінці Add Patrol введіть ідентифікатор і назву маршруту, а потім натисніть Add для додавання дії патрулювання. Можна додати до 64 дій. Якщо вибрано тип дії Move Direction і Zoom, кожен рядок включає дві дії, таким чином, можна задати лише 32 ...
	4. Натисніть OK.

	Запис маршруту патрулювання
	1. На сторінці Live View натисніть Patrol на панелі інструментів.
	2. Щоб почати запис маршруту патрулювання, натисніть . Ви можете змінювати напрям і зум камери під час запису. Система записує рух і маршрут камери, а потім додає їх до списку дій.
	3. Щоб завершити запис, натисніть . Після цього маршрут патрулювання автоматично зберігається як бажаний. Ви можете натиснути , щоб запустити патрулювання, або , щоб видалити бажаний маршрут.

	Складання плану патрулювання
	1. На сторінці Live View натисніть Patrol на панелі інструментів.
	2. Натисніть . Відкриється сторінка для складання планів патрулювання.
	3. Встановіть час і маршрут патрулювання.
	4. Виберіть Enable Patrol Plan.
	5. Натисніть OK.

	Запуск маршруту патрулювання
	1. На сторінці Live View натисніть Patrol на панелі інструментів.
	2. Натисніть  для маршруту патрулювання, який ви хочете запустити.

	Зміна маршруту патрулювання
	1. На сторінці Live View натисніть Patrol на панелі інструментів.
	2. Натисніть  для маршруту патрулювання, який ви хотите редагувати, і змініть налаштування відповідно до ваших потреб.

	Видалення маршруту патрулювання
	1. На сторінці Live View натисніть Patrol на панелі інструментів.
	2. Натисніть  для маршруту патрулювання, який ви хотите видалити, і підтвердіть видалення.



	Встановлення початкового положення
	1. Натисніть Setup > PTZ > Home Position.
	2. Виберіть режим і ідентифікатор.
	3. Натисніть кнопку Save для збереження.

	Дистанційне керування PTZ
	1. Натисніть Setup > PTZ > Remote Control.
	2. Для активації функції Remote Control виберіть On. Вкажіть порт прослуховування і код адреси. У таблиці нижче описано деякі основні параметри.
	3. Натисніть кнопку Save для збереження.

	Межа PTZ
	1. Натисніть Setup > PTZ > PTZ Limit.
	2. Щоб повернути камеру в задане положення, використовуйте кнопки зі стрілками.
	3. Натисніть  для встановлення поточного положення як обмеження. Наприклад, натисніть  вгорі, щоб встановити верхню межу. Натискання значка  призведе до повороту камери в поточне положення, якщо напрямок було змінено.
	4. Повторіть вищенаведені кроки, щоб встановити всі обмеження по мірі необхідності (зверху, знизу, зліва і справа).
	5. Натисніть кнопку Save для збереження.
	6. Натисніть Start PTZ Limit для застосування налаштувань.
	7. Натисніть , щоб скинути налаштування і встановити межу знову.

	Відновлення патрулювання
	1. Натисніть Setup > PTZ > Patrol.
	2. Вкажіть час відновлення патрулювання.
	3. Натисніть кнопку Save для збереження.


	7   Розпізнавання номерних знаків
	Розпізнавання номерних знаків у реальному часі
	1. Для камер зі встановленою картою Micro SD знімки будуть збережені на SD-карту. Якщо SD-карта не встановлена, знімки будуть збережені на ПК. Для перегляду знімків натисніть Open Image Folder. Зображення знака крупним планом буде представлено у верхн...
	2. Для видалення всіх знімків натисніть Clear All Records.
	Налаштування розпізнавання номерних знаків у реальному часі
	Позначення зони виявлення
	1. Натисніть Setup > Intelligent> Traffic Monitoring. Натисніть Draw Detection Rules.
	2. Натисніть Draw Detection Rules і намалюйте зону виявлення на знімку.
	3. Натисніть Inclination Line і накресліть лінію, що показує нахил поверхні дороги.

	Скинути лічильник потоку
	Натисніть Setup > Intelligent > Traffic Monitoring > Smart > Reset Flow Counting. Встановіть час скидання знімка розпізнаного номерного знака.

	Інтелектуальна обробка знімків
	Натисніть Setup > Intelligent > Traffic Monitoring > Snapshot Handling. Зазвичай рекомендується використовувати налаштування за замовчуванням.
	Нерозпізнані транспортні засоби: виберіть, чи потрібно генерувати облік проходження нерозпізнаних транспортних засобів. Ця функція за замовчуванням увімкнена.
	Зроблені фотографії: виберіть, чи потрібно відображати номерний знак крупним планом. За замовчуванням відображення увімкнено.

	Фотографія
	Натисніть Setup > Intelligent > Traffic Monitoring > Photo. На цій сторінці можна налаштувати екранний інтерфейс.




	Додаток A. Глосарій
	Додаток B. Поширені запитання
	Що робити, якщо немає повідомлення з вимогою встановити ActiveX під час першого входу в систему на ПК з Windows 7?
	1. Натисніть кнопку Start, а потім натисніть Control Panel.
	2. У вікні пошуку введіть контроль облікових записів, а потім натисніть Change User Account Control Settings .
	3. Перемістіть повзунок у положення Never Notify, а потім натисніть ОК.
	4. Після вимикання контролю облікових записів знову увійдіть в систему.

	Що робити, якщо встановлення ActiveX завершилось невдачею?
	Що робити, якщо при першому вході в систему не запускаєтся режим перегляду відео в реальному часі?


